
ÄKTA ready™
Operating Instructions
Original instructions

cytiva.com

http://cytiva.com


Table of Contents

1 Introduction ........................................................................................................ 5
1.1 Important user information ....................................................................................................................... 6
1.2 About this manual ......................................................................................................................................... 8
1.3 Associated documentation ....................................................................................................................... 10
1.4 Additional user documentation - additional/specific documentation ...................................... 12
1.5 Abbreviations .................................................................................................................................................. 13

2 Safety instructions ............................................................................................. 14
2.1 Safety precautions ........................................................................................................................................ 15
2.2 Labels and symbols ....................................................................................................................................... 19
2.3 Emergency procedures ............................................................................................................................... 21

3 System description ............................................................................................ 24
3.1 Overview ............................................................................................................................................................ 25
3.2 System illustrations ...................................................................................................................................... 26
3.3 System components ..................................................................................................................................... 31

3.3.1 Skid and electrical cabinet ....................................................................................................................... 32
3.3.2 Pumps ............................................................................................................................................................... 33
3.3.3 Valves ................................................................................................................................................................ 34

3.4 Flowchart .......................................................................................................................................................... 36
3.5 Flow kits ............................................................................................................................................................. 38

3.5.1 Flow kit overview ........................................................................................................................................... 39
3.5.2 Flow kit sensors ............................................................................................................................................. 44

3.6 UNICORN control system ........................................................................................................................... 47

4 Installation .......................................................................................................... 49
4.1 Safety precautions ........................................................................................................................................ 50
4.2 Site requirements .......................................................................................................................................... 53
4.3 Included in the delivery ................................................................................................................................ 54
4.4 Unpacking ......................................................................................................................................................... 55

4.4.1 Unpack ÄKTA ready .................................................................................................................................... 56
4.4.2 Unpack the flow kit ....................................................................................................................................... 57

4.5 Transport .......................................................................................................................................................... 58
4.6 Connections ..................................................................................................................................................... 61

4.6.1 Connect power .............................................................................................................................................. 62
4.6.2 Connect compressed air ........................................................................................................................... 64
4.6.3 Connection of COMMON WASTE Outlet .......................................................................................... 65
4.6.4 Connect computer ....................................................................................................................................... 66
4.6.5 Connect equipment to CUSTOMER I/O connector ...................................................................... 67

4.7 Finish installation ........................................................................................................................................... 70

5 Operation ............................................................................................................ 72
5.1 Safety precautions ........................................................................................................................................ 73
5.2 Start the system and log on to UNICORN ............................................................................................ 76
5.3 Install flow kit ................................................................................................................................................... 78

5.3.1 Prepare for flow kit installation ............................................................................................................... 79
5.3.2 Create flow kit installation method ....................................................................................................... 81

Table of Contents

ÄKTA ready Operating Instructions 28960345 AG 2



5.3.3 Install the flow kit for isocratic run ........................................................................................................ 83
5.3.4 Install the flow kit for gradient run ........................................................................................................ 101

5.4 Perform a component test ......................................................................................................................... 106
5.4.1 Run a component test ................................................................................................................................ 107
5.4.2 The test report ............................................................................................................................................... 111

5.5 Connect a column .......................................................................................................................................... 112
5.5.1 Install a column ............................................................................................................................................. 113
5.5.2 Run a column efficiency test (optional) ............................................................................................... 121
5.5.3 Rinse a column (optional) .......................................................................................................................... 124

5.6 Set ÄKTA ready specific parameters in Method Editor ................................................................ 125
5.6.1 Set UV stray light calibration ................................................................................................................... 126
5.6.2 Set flow meter fine tuning ......................................................................................................................... 128
5.6.3 Set totalizers ................................................................................................................................................... 129
5.6.4 Set PressureFlowControl ..................................................................................................................... 131

5.7 Run a method .................................................................................................................................................. 134
5.7.1 Prepare before a run ................................................................................................................................... 135
5.7.2 Run a method ................................................................................................................................................. 141

5.8 Controlled shutdown .................................................................................................................................... 144

6 Maintenance ....................................................................................................... 147
6.1 Safety precautions ........................................................................................................................................ 148
6.2 Maintenance schedule ................................................................................................................................ 150
6.3 Maintenance procedures ........................................................................................................................... 151
6.4 Calibration ........................................................................................................................................................ 155

6.4.1 Calibrate sensors .......................................................................................................................................... 156
6.4.2 Calibrate the gradient pump ................................................................................................................... 165

6.5 Cleaning ............................................................................................................................................................ 170
6.6 Storage .............................................................................................................................................................. 172

7 Troubleshooting ................................................................................................. 173
7.1 Troubleshooting the system ..................................................................................................................... 174
7.2 Troubleshooting a failed component test ........................................................................................... 181

8 Reference information ....................................................................................... 183
8.1 Specifications .................................................................................................................................................. 184
8.2 Chemical resistance ..................................................................................................................................... 185
8.3 Environmental requirements .................................................................................................................... 187
8.4 PID control ........................................................................................................................................................ 188
8.5 Recycling information .................................................................................................................................. 190
8.6 Regulatory information ............................................................................................................................... 192

8.6.1 Contact information .................................................................................................................................... 193
8.6.2 European Union and European Economic Area .............................................................................. 194
8.6.3 Great Britain ................................................................................................................................................... 195
8.6.4 Eurasian Economic Union (Евразийский экономический союз) .......................................... 196
8.6.5 North America ............................................................................................................................................... 198
8.6.6 General regulatory statements .............................................................................................................. 199
8.6.7 China .................................................................................................................................................................. 200
8.6.8 Other regulations and standards .......................................................................................................... 203

8.7 Flow kit ordering information .................................................................................................................... 204
8.8 More information ........................................................................................................................................... 205
8.9 Health and Safety Declaration Form ...................................................................................................... 206

Table of Contents

ÄKTA ready Operating Instructions 28960345 AG 3



Index ........................................................................................................................... 208

Table of Contents

ÄKTA ready Operating Instructions 28960345 AG 4



1 Introduction

About this chapter
This chapter contains information about this manual and associated user documenta-
tion, important user information, and intended use of the product.

In this chapter

Section See page

1.1 Important user information 6

1.2 About this manual 8

1.3 Associated documentation 10

1.4 Additional user documentation - additional/specific docu-
mentation

12

1.5 Abbreviations 13

1 Introduction
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1.1 Important user information

Introduction
This section contains important user information about the product and this manual.

Read this before operating the
product

All users must read the entire Operating Instructions before installing, oper-
ating, or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not install, operate, or perform maintenance on the product in any other way than
described in the user documentation. If you do, you may be exposed or expose others
to hazards that can lead to personal injury and you may cause damage to the equip-
ment.

Intended use of the product
ÄKTA ready™ is intended to be operated as an isocratic or gradient, low pressure, auto-
mated liquid chromatography system using corresponding isocratic or gradient flow
kit and ReadyToProcess™ columns.

ÄKTA ready is controlled by UNICORN™ software.

The system is based on proven liquid chromatography techniques, such as ion
exchange, affinity chromatography, and hydrophobic interaction.

ÄKTA ready is biocompatible and hygienic, and meets all GLP and cGMP demands for
drug development and manufacturing.

ÄKTA ready is not approved for use in a potentially explosive atmosphere or for
handling flammable liquids.

Flow kits and columns are not included in the system and are ordered separately. See
the Cytiva website for ordering information and lists of available flow kits.

Prerequisites
In order to operate the system in the way it is intended, the following prerequisites
must be fulfilled:

• The user must be acquainted with the use of general bioprocessing equipment and
with handling of biological materials.

• The user must read and understand the Safety Instructions chapter in the Oper-
ating Instructions.

1 Introduction
1.1 Important user information
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• The user must have a working knowledge of UNICORN software. A user account
must have been created according to the UNICORN Administration and Technical
Manual (29191899).

• The user must have a working knowledge of Windows operating system.

• The system must be installed in accordance with the site requirements and instruc-
tions in the Operating Instructions.

1 Introduction
1.1 Important user information
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1.2 About this manual

Introduction
This section contains information about the purpose and scope of this manual, notes
and tips, and typographical conventions.

Purpose of this manual
This manual provides information needed to install, operate and maintain the product
in a safe way.

Scope of this manual
This Operating Instructions manual is valid for the ÄKTA ready and
ÄKTA ready gradient systems. Both systems are also referred to as "the products" in
this manual. This manual also describes the isocratic and gradient flow kits used with
the ÄKTA ready and ÄKTA ready gradient systems, respectively.

The illustration below shows ÄKTA ready gradient system (A) and ÄKTA ready system
(B). Both systems are shown with the flow kit, the connected ReadyToProcess column,
and the column trolley.

A

B

The systems are operated using UNICORN.

Detailed information about columns, chromatography resins and buffer tanks is not
included in this manual.

1 Introduction
1.2 About this manual
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Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your proce-
dures.

Typographical conventions
Software items are identified in the text by bold italic text.

Hardware items are identified in the text by bold text.

Tip: The text can include clickable hyperlinks to reference information.

1 Introduction
1.2 About this manual
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1.3 Associated documentation

Introduction
This section describes the user documentation delivered with the product, and how to
find related literature that can be downloaded or ordered from Cytiva.

User documentation for ÄKTA ready
The user documentation is listed in the table below.

Translations of the Operating Instructions are provided on the User Documentation CD
(or USB flash drive) together with the Product Documentation, and Unpacking Instruc-
tions.

Documentation Main contents

ÄKTA ready Operating Instructions
(28960345)

(this document)

Instructions needed to prepare and
operate the ÄKTA ready system in a
correct and safe way.

System overview, site requirements,
and instructions for moving the system
within the same building.

Instructions for basic maintenance and
troubleshooting.

ÄKTA ready Site Preparation Guide
(29135897)

Information needed to prepare the site
for installation and use of the
ÄKTA ready system.

ÄKTA ready Unpacking Instructions
(28994489)

Instructions for handling the delivery
package and unpacking the ÄKTA ready
system.

ÄKTA ready Flow Kit Product Documen-
tation (28930007)

Describes the ÄKTA ready Flow Kit
general specifications and material
conformity.

1 Introduction
1.3 Associated documentation
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Related literature
This list describes related literature that can be downloaded or ordered from Cytiva.
Contact your Cytiva representative for more details.

Document name Description Product code

ReadyToProcess columns User Manual User Manual 28925644

ReadyToProcess columns Data file 28915987

Keep your ÄKTA ready operating in peak condition Preventive Mainte-
nance PM Fact Sheet

28998083

Process chromatography: A guide to optimization,
scale-up and validation

Handbook 18112156

Efficiency test of ReadyToProcess columns Application note 28919821

Ready-to-use fluid management solutions for chroma-
tography systems

Application note 28995879

Purification of a monoclonal antibody using ReadyTo-
Process columns

Application note 28919856

Downstream scale-up purification of influenza virus
using ReadyToProcess equipment

Application note 29043549

Connected polishing and concentration under one
automation method

Application note KA985271017AN

Access user documentation online
Scan the QR code or visit cytiva.com/instructions. Enter the title or the document
number to access the file.

1 Introduction
1.3 Associated documentation
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1.4 Additional user documentation - additional/specific
documentation

Introduction
This section describes the product-specific documentation delivered with the product
and component documentation.

Product-specific documentation
In addition to the Operating Instructions manual, the documentation package supplied
with the product also includes detailed specifications and traceability documents.

The following table provides examples of technical specification documents that can
be found in the documentation package delivered with the product.

Document Abbrevia-
tion

Purpose/Contents

Piping and Instrumen-
tation Diagram

P&ID Schematic overview of the process flow,
components and instruments and the
control system.

General Specification GS Technical data for the system.

General arrangement
drawing

GAD Physical layout. Provides dimensional
data.

Bill of Material BOM Description of process-related compo-
nents, including wetted materials and
specifications.

Declaration of
Conformity

DoC Declaration of Conformity for EU and/or
other regions.

Spare Part List SPL List of spare parts available from Cytiva.

Component documentation
Documentation for components produced both by Cytiva and by a third-party are, if
existent, also included in the Product Documentation.

1 Introduction
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1.5 Abbreviations

Introduction
This section explains abbreviations that are used in the user documentation for
ÄKTA ready.

Abbreviations

Abbreviation Definition (English) Translation (local language)

cGMP Current Good Manufacturing Prac-
tices

Current Good Manufacturing Prac-
tices

CIP Cleaning-in-place Cleaning-in-place

GLP Good laboratory practice Good laboratory practice

HV Manually actuated valve (hand valve) Manually actuated valve (hand valve)

I/O Input/Output Input/Output

PID Proportional integral derivative Proportional integral derivative

rpm Revolutions per minute Revolutions per minute

TC Hygienic tubing connection Hygienic tubing connection

UPS Uninterruptible power supply Uninterruptible power supply

XV Pneumatically actuated valve (auto-
matic valve)

Pneumatically actuated valve (auto-
matic valve)

1 Introduction
1.5 Abbreviations
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2 Safety instructions

About this chapter
This chapter describes safety precautions, labels and symbols that are attached to the
system. In addition, the chapter describes emergency and recovery procedures.

In this chapter

Section See page

2.1 Safety precautions 15

2.2 Labels and symbols 19

2.3 Emergency procedures 21

Important

WARNING
All users must read and understand the entire contents of
this general safety chapter, and the specific safety precau-
tions information in each subsequent chapter of this manual
to become aware of the hazards involved.

2 Safety instructions
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2.1 Safety precautions

Introduction
ÄKTA ready is powered by mains voltage and handles materials that can be hazardous.

Before installing, operating, or maintaining the system, you must be aware of the
hazards described in this manual.

The general precautions presented in this chapter must be considered at all times. The
context related precautions are located in their respective chapters.

Definitions
This user documentation contains safety notices (WARNING, CAUTION, and NOTICE)
concerning the safe use of the product. See definitions below.

WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to proceed
until all stated conditions are met and clearly understood.

CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

General precautions
The following general precautions must be considered at all times. There are also
context related precautions, which are written in their respective chapters.

2 Safety instructions
2.1 Safety precautions
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WARNING

Risk assessment. Perform a risk assessment for the process or
process environment. Evaluate the effects the use of the product
and the operational processes may have on the classification of the
hazardous area. The process can cause the hazardous area to
increase or the zone classification to change. Implement the risk
reduction measures needed, including use of personal protective
equipment.

WARNING

Do not operate the product in any other way than as described in
the user documentation.

WARNING

All installation, maintenance, operation, and inspection must be
carried out according to local regulations by adequately trained
personnel.

WARNING

Protective earth. The product must be connected to protective
earth when energized.

WARNING

Only authorized personnel may open the electrical cabinet doors.
There is hazardous voltage inside the electrical cabinet that can
cause human injury or death.

WARNING

Hazardous voltage. The electric cabinet doors may only be
opened when the system is taken out of operation and subject to
Lock Out / Tag Out (LOTO).

2 Safety instructions
2.1 Safety precautions
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WARNING

Do not use the product if it is not working properly, or if it has
suffered any damage including:

• damage to the power cord or its plug,

• damage caused by dropping the product,

• damage caused by splashing liquid onto the product.

WARNING

Emergency stop. Pressing the EMERGENCY STOP does not
automatically depressurize the flow path.

WARNING

Emergency stop. Pressing the EMERGENCY STOP does not shut
off mains power to the cabinet.

WARNING

Do not use any accessories not supplied or recommended by
Cytiva.

Personal protection

WARNING
Always use appropriate Personal Protective Equipment (PPE)
during operation and maintenance of this product.

WARNING

Hazardous substances and biological agents. When using
hazardous chemicals and biological agents, take all suitable
protective measures, such as wearing protective clothing, glasses
and gloves resistant to the substances used. Follow local and/or
national regulations for safe operation and maintenance of this
product.

2 Safety instructions
2.1 Safety precautions
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CAUTION

Personal Protective Equipment (PPE). Whenever packing,
unpacking, transporting or moving the system, wear:

• Protective footwear, preferably with steel lining

• Working gloves, protecting against sharp edges

• Protective glasses

WARNING

Corrosive substance. NaOH is corrosive and therefore dangerous
to health. When using hazardous chemicals, avoid spillage and
wear protective glasses and other suitable Personal Protective
Equipment (PPE).

Flammable liquids and explosive
environment

WARNING

Flammable liquids. This product is not approved for handling
liquids under conditions when they can be flammable.

WARNING

Explosion hazard: The product is not approved for use in a
potentially explosive atmosphere. The product does not fulfill the
requirements of the ATEX Directive.

WARNING

Some of the chemicals used with the system can be flammable
under certain conditions. Make sure to use chemicals only under
conditions where they are not flammable. Refer to local and/or
national classifications of flammable liquids.

2 Safety instructions
2.1 Safety precautions

ÄKTA ready Operating Instructions 28960345 AG 18



2.2 Labels and symbols

Introduction
This section describes the nameplate, labels, and other safety and regulatory informa-
tion attached to the product.

System nameplate
The following symbols and text may be present on the system label.

Symbol/text Description

Code Number The number that identifies the system as
ÄKTA ready.

System Number The unique system installation number.

Manufacturing Year/
Month

Manufacturing year and month.

Supply Voltage Voltage alternatives for ÄKTA ready.

Configured For Voltage the system is currently configured for.

Frequency Supply voltage frequency.

Max Power Consumption Maximum effect of the system.

Pneumatic Supply Pneumatic supply pressure requirement.

Protection Class Protection class. Ingress protection according to IEC
60529.

This symbol indicates that the waste of electrical and
electronic equipment must not be disposed of as
unsorted municipal waste and must be collected
separately. Contact an authorized representative of
the manufacturer for information concerning the
decommissioning of equipment.

Warning! Read the user documentation before
using the system. Do not open any covers or replace
parts unless specifically stated in the user documen-
tation.

Safety labels
The table below describes the various safety labels that can be found on the system.

2 Safety instructions
2.2 Labels and symbols
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Symbol/Text Description

Warning! Read the user documentation before using
ÄKTA ready. Do not open any covers or replace parts
unless specifically stated in the user documentation.

Warning! Hazardous voltage. Disconnect power
before servicing. Authorized personnel only.

Warning! Pinch hazard. Never put your fingers or
any objects other than the intended tubing in the
pinch valve openings. Make sure that clothing or other
equipment does not get caught in the pinch valves.

Warning! Rotating rollers/cogwheels. Never touch
the pump or pump lid while the pump is running.

2 Safety instructions
2.2 Labels and symbols
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2.3 Emergency procedures

Introduction
This section describes how to shut down the ÄKTA ready system in an emergency
situation, and the procedure for restarting the system.

The section also describes the result in the event of power failure.

Safety precautions

WARNING

Emergency stop. Pressing the EMERGENCY STOP does not shut
off mains power to the cabinet.

WARNING

Pressurized flow path. During a power failure or emergency stop,
the equipment can remain pressurized. Make sure all lines and
vessels are depressurized before opening a line or vessel.

WARNING
Access to power switch and power cord. The power switch
must always be easy to access. The power cord must always be
easy to disconnect.

Emergency shutdown

In an emergency situation, follow the steps below to stop the run.

2 Safety instructions
2.3 Emergency procedures
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Step Action

1 Push the EMERGENCY STOP button on the front of the system cabinet.

Result:

The pump motor stops immediately. The system is set in Pause mode.

2 Turn the MAINS POWER switch to the O position to completely turn off
power to the system.

3 Release the pressure from all lines and the vessel if you need to open the
connections: press and hold the AIR VENT button to open the air trap valve.

Power failure
The following table describes the consequences of power failure to parts of the system.

Power failure Result

ÄKTA ready cabinet • The pump stops immediately.

• The valves change to their default position.

• The connection to the control software is lost
and UNICORN shows the Connection lost
message.

• The data is temporarily stored in the control unit
CU960.

After the power is restored, the run goes to the End
state. The temporarily stored data is automatically
copied to UNICORN.

2 Safety instructions
2.3 Emergency procedures
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Power failure Result

Computer • The computer and UNICORN shut down.

• The connection between UNICORN and
ÄKTA ready is lost.

• The run continues, and data is temporarily
stored in the control unit CU960.

After the power and the connection are restored,
the temporary data from the control unit CU960 is
automatically copied to UNICORN. The run
continues and can be accessed again through
UNICORN.

Compressed air system • The inlet and outlet valves close.

• All other valves open.

• The pressure is released through the air trap.

Note:

The purification product may be damaged.

Connection to a UPS can enable the system to continue to operate for a limited time. A
UPS is not included with the system. Contact your local Cytiva representative for more
information about the options for your specific system.

Restart after emergency shutdown or
power failure

To restart the system, follow the steps below:

Step Action

1 Make sure that the condition that caused the power failure or emergency
stop is corrected.

2 Reset the EMERGENCY STOP button by turning it clockwise.

3 Click Continue in UNICORN.

2 Safety instructions
2.3 Emergency procedures
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3 System description

About this chapter
This chapter provides an overview of the technical properties of the ÄKTA ready
system.

In this chapter

Section See page

3.1 Overview 25

3.2 System illustrations 26

3.3 System components 31

3.4 Flowchart 36

3.5 Flow kits 38

3.6 UNICORN control system 47

3 System description
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3.1 Overview

Description
ÄKTA ready is an automated, low pressure liquid chromatography system that can be
operated as an isocratic or a gradient system. ÄKTA ready is used together with the
isocratic or gradient flow kit and ReadyToProcess columns.

The documents referred to are part of the documentation package provided in the
delivery.

System overview
ÄKTA ready consists of a stainless steel electrical cabinet and a skid. The cabinet has
valves and holders for fitting a flow kit (isocratic or gradient). The system is equipped
with four polyurethane casters. Two casters are lockable. The system is equipped with
transmitters and connection points for the flow kit sensors and meters.

The system is easy to move and keep clean and is designed for use in a production envi-
ronment.

Refer to the Bill of Material for more detailed information on the type of transmitters.
Refer to the General Specification for information on the materials of construction.

Control system overview
The system is controlled by the UNICORN software from a free-standing computer. The
computer is not supplied with the ÄKTA ready system.

NOTICE

The computer used with the system must comply with IEC 60950
and be installed and used according to the manufacturer's instruc-
tions.

For more information see Section 3.6 UNICORN control system, on page 47.

3 System description
3.1 Overview
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3.2 System illustrations

ÄKTA ready with a flow kit

1

2

3

4

 

Part Function

1 ÄKTA ready cabinet

2 ReadyToProcess column (ordered separately)

3 ÄKTA ready flow kit (ordered separately)

Note:

See Section 3.5.1 Flow kit overview, on page 39 for more information.

4 Column trolley

3 System description
3.2 System illustrations
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ÄKTA ready gradient with a flow kit
The gradient pump is an optional component of the ÄKTA ready.

2

1

 

Part Function

1 ÄKTA ready gradient pump

2 ÄKTA ready gradient flow section

Note:

See Section 3.5.1 Flow kit overview, on page 39 for more information.

3 System description
3.2 System illustrations
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ÄKTA ready detailed view
The following illustration shows a detailed view of the ÄKTA ready cabinet front. The
system is shown with an isocratic flow kit.

1

2

3

4

5

6

7

11

10

8

9

12

13

14

Part Component ID tag Description

1 PAUSE/
CONTINUE
button and alarm
indicator lamp

N/A1 Pressing the button pauses an ongoing process.
Pressing second time continues the process.

Shows steady yellow light during pause. Flashing
yellow light indicates UNICORN alarm.

2 RUN indicator
lamp

N/A1 Shows green light when the system is running. No light
when system is idle (e.g., between runs or during
pause).

3 POWER indi-
cator lamp

N/A1 Shows flashing green light during initial communica-
tion connection with UNICORN software, when power
is switched on. Steady green light when power is on
and communication is established.

3 System description
3.2 System illustrations
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Part Component ID tag Description

4 EMERGENCY
STOP button

N/A1 Stops the pump and places the system in Pause
mode.

5 Handle N/A1 Used to move the system.

6 System pump P-201 Peristaltic pump for buffer and sample input.

7 Inlet valves XV-001 to
XV-006

Six valves for liquid input.

8 Air filter N/A1 Cabinet air filter.

9 Column valves XV-031 to
XV-033

Three valves for column connection or bypass.

10 Air trap valves XV-021 to
XV-023

Three valves for putting the air trap inline or bypass.

11 Air trap holder N/A1 Holder for the air trap.

12 Outlet valves XV-051 to
XV-056

Six valves for liquid outlet.

13 AIR VENT button N/A1 Opens the HV-301 valve for releasing excess air from
the air trap.

14 Air trap vent
valve

HV-301 Manual valve controlling the air flow to the air trap.

1 Not applicable.

Installation switch
The installation switch is located on the front of the ÄKTA ready cabinet, in the upper
right corner. The installation switch is used for opening and closing the valves during
the flow kit installation and the column installation. The positions of the installation
switch are described below.

3 System description
3.2 System illustrations
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Position Description

FLOW KIT
INSTALL

All valves are open. The user can manually open and close the
valve safety locks.

RUN All valves are engaged and controlled by UNICORN. The user
cannot open the valve safety locks.

COLUMN
INSTALL

The valves between air trap outlet and column inlet are open.
Air can be removed from the tubing between the column and
the air trap.

Connectors
Connectors for system power, pressurized air, customer I/O, and computer network
are located on the back of the system. The following illustration shows the location of
the connectors.

1 2 3 4

Part ID tag Description

1 POWER SUPPLY System power cable

2 PNEUMATIC AIR SUPPLY Compressed air connector

3 SYSTEM COMPUTER Ethernet network connector

4 CUSTOMER I/O User I/O connector

3 System description
3.2 System illustrations
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3.3 System components

Introduction
This section provides the overview of ÄKTA ready components.

For further details and specifications refer to the documentation package provided
with the system.

In this section

Section See page

3.3.1 Skid and electrical cabinet 32

3.3.2 Pumps 33

3.3.3 Valves 34

3 System description
3.3 System components
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3.3.1 Skid and electrical cabinet

Skid and cabinet
The ÄKTA ready hardware consists of a stainless steel cabinet that is placed on a skid.
The stainless steel cabinet contains electrical and pneumatic components, and the
control unit. The isocratic pump is attached to the cabinet.

Control unit CU-960
A CU-960 control unit is the controlling interface between UNICORN and the compo-
nents of ÄKTA ready. The CU-960 is located inside the electrical cabinet.

The CU-960 has capabilities to store real time data during short disconnection from
the computer. Data stored on the CU-960 can be uploaded to the computer when
communication with the computer is re-established. Data upload from the CU-960 to
the computer is shown on the monitor and can take several minutes. ÄKTA ready can
control the system again when the data upload is completed.

For more information about uploading data from the CU-960 refer to the UNICORN
manual package.

NOTICE

Unsaved data are lost, if UNICORN or the Windows operating
system are forced to close during data upload.
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3.3.2 Pumps

Description
ÄKTA ready is equipped with one or two pumps depending on the configuration.

• Pump P-201 is used for isocratic operation.

• Pumps P-201 and P-202 are used for gradient operation.

Each pump is a peristaltic pump with the capacity up to 510 L/h at a back pressure up
to 4 bar g.

A peristaltic pump is a pump without valves or seals, avoiding clogging or corrosion.
The liquid is in contact only with the inside of the tubing that eliminates the risk of
contamination. For specifications refer to the General Specification or the manufac-
turer's user documentation in the product documentation package.
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3.3.3 Valves

Pinch valves
Pinch valves are used to control the path of the liquid through the flow kit. The valves
have manually operated safety locks keeping the tubing in place and preventing the
valves from accidentally closing during the flow kit installation. Each safety lock is
opened by lifting the black handle and turning it outward, and closed by turning the
handle inward.

The following illustration shows an unlocked (A) and a locked (B) pinch valve.

1

2

A B

Part Description

1 Safety lock (manually operated)

2 Pinch valve opening for tubing

All valves on the ÄKTA ready system are pinch valves. The system has 19 pinch valves.

WARNING

Never put fingers or any objects other than the intended tubing
into the pinch valve opening.

Air trap valves
The air trap valve set consists of three valves. The table below shows the state of the air
trap valves at specific valve positions.

Valve position Open valves

Bypass XV-021

Inline (default) XV-022 + XV-023
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When the system is set to the Pause mode, the air trap valves remain in the same posi-
tion as during the run. The user can change this setting in the System Settings in
UNICORN.

Column valves
The column valve set consists of three valves.

The table below shows the state of the column valves at specific valve positions.

Valve position Open valves

Bypass XV-031

Inline XV-032 + XV-033
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3.4 Flowchart

Flowchart illustration
The following illustration shows a schematic diagram of the ÄKTA ready flow path.
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Color Description

Black Isocratic flow kit components

Red Gradient flow section

Blue Column

Gray Valve blocks

The table below describes the system components shown in the flowchart.

Label Description

AE-121 pH electrode (optional)

AE-131 UV sensor

AT-221 Air trap

CE-101 Conductivity sensor

FE-141 Flow meter

HV-301 Air trap vent valve

P-201 System pump

P-202 Gradient pump (optional)
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Label Description

PT-111 to PT-113 Pressure sensors

TE-161 Temperature sensor

XV-001 to XV-006 Buffer A inlet valves

XV-051 to XV-056 Outlet valves

Pressure limits
The table below specifies the maximum operating pressure of parts A to D in the flow
path, as shown in the flowchart.

Part Description Pressure

A Inlet valves 0.6 bar (0.06 MPa)

B Pump, pre-column pressure sensor
PT-111, air trap and column

5.0 bar (0.5 MPa)

C Post-column sensors 2.0 bar (0.2 MPa)

D Outlet valves and post-column
pressure sensor PT-113

0.95 bar (0.095 MPa)
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3.5 Flow kits

Introduction
This chapter provides descriptions of the disposable flow kits and an overview of the
components.

The flow kit specifications are described in the product documentation provided with
each flow kit.

In this section

Section See page

3.5.1 Flow kit overview 39

3.5.2 Flow kit sensors 44
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3.5.1 Flow kit overview

Description
ÄKTA ready can be used for isocratic or gradient operation. The table below shows the
flow kit components needed for these operations.

Operation mode Required flow kit parts

Isocratic • Flow kit

Gradient • Flow kit

• Gradient flow section

For specifications and material information, refer to the product documentation
provided with the flow kit. For chemical resistance of the flow kit, see Allowed chemi-
cals, on page 185.

Illustration of the isocratic flow kit
Note: Some flow kit components are flow cells for sensors that are located on the

system cabinet. Their ID tags technically refer to the sensors, not to the flow
cells. In the table further down the tags are used for identification of both the
sensors and the corresponding flow cells.

The following illustration shows the isocratic flow kit.
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Part Component ID tag Description

1 Air vent tubing N/A1 Air flow to and from the air trap. Manually controlled
by the AIR VENT button through valve HV-301.

2 Air trap AT-221 Allows removal of air from buffers and sample.
Manually filled with liquid by pressing the AIR VENT
button (air is released).

3 Pressure sensor PT-111 Measures the pressure after the pump. Part of the
safety monitoring of the high pressure.

4 Pump tubing N/A1 Liquid input using a peristaltic pump.

5 Inlet manifold XV-001 to
XV-006

Manifold for liquid input. The six inlets correspond to
valves XV-001 to XV-006.

6 Column inlet
tubing

N/A1 Connection to column inlet.

7 Column outlet
tubing

N/A1 Connection to column outlet.

8 Pressure sensor PT-112 Measures the post-column pressure. Part of the safety
monitoring of the medium pressure.

9 pH electrode
(optional)

AE-121 The sensor for pH measurement (optional). The elec-
trode is attached to the flow cell of pressure sensor
PT-112, replacing the dummy electrode in the holder.

10 Flow meter FE-141 Measures the liquid flow rate, using ultrasound.

11 Temperature
sensor

TE-161 Measures liquid temperature. The sensor uses
infrared light and is integrated with the flow meter
FE-141.

12 Conductivity
sensor

CE-101 Measures liquid conductivity.

13 UV sensor AE-131 The flow cell for UV detector AE-131.

14 Outlet manifold XV-051 to
XV-056

Manifold for liquid outlet. The six outlets correspond to
valves XV-051 to XV-056.

15 Pressure sensor PT-113 Measures the pressure after the column and all other
sensors. Part of the safety monitoring of the low pres-
sure.

1 Not applicable.

Illustration of the gradient flow kit
The gradient flow kit contains the same components as the isocratic flow kit, and in
addition this kit contains the gradient flow section. The gradient flow section
comprises the jumper tubing and the pump tubing for a gradient run.

The image below shows the complete gradient flow kit. See further down for the
detailed image of the gradient flow section.
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Part Component ID tag Description

1 Air vent tubing N/A1 Air flow to and from the air trap. Manually controlled
by the AIR VENT button through valve HV-301.

2 Air trap AT-221 Allows removal of air from buffers and sample.
Manually filled with liquid by pressing the AIR VENT
button (air is released).

3 Pressure sensor PT-111 Measures the pressure after the pump. Part of the
safety monitoring of the high pressure.

4 Inlet manifold XV-001 to
XV-006

Manifold for liquid input. The six inlets correspond to
valves XV-001 to XV-006.

5 System pump
tubing

N/A1 Liquid input using a peristaltic pump.

Note:
This tubing is installed in the system pump (P-201) for
gradient method only.

6 Gradient pump
tubing

N/A1 Liquid input using a peristaltic pump.

Note:
This tubing is installed in the gradient pump (P-202)
for gradient methods.
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Part Component ID tag Description

7 Jumper tubing N/A1 Connects the pump tubing to the main part of the flow
kit (for gradient method only).

8 Column inlet
tubing

N/A1 Connection to column inlet.

9 Column outlet
tubing

N/A1 Connection to column outlet.

10 Pressure sensor PT-112 Measures the post-column pressure. Part of the safety
monitoring of the high pressure.

11 pH electrode
(optional)

AE-121 The sensor for pH measurement (optional). The elec-
trode is attached to the flow cell of pressure sensor
PT-112, replacing the dummy electrode in the holder.

12 Flow meter FE-141 Measures the liquid flow rate, using ultrasound.

13 Temperature
sensor

TE-161 Measures liquid temperature. The sensor uses
infrared light and is integrated with the flow meter
FE-141.

14 Conductivity
sensor

CE-101 Measures liquid conductivity.

15 UV sensor AE-131 The flow cell for UV detector AE-131.

16 Outlet manifold XV-051 to
XV-056

Manifold for liquid outlet. The six outlets correspond to
valves XV-051 to XV-056.

17 Pressure sensor PT-113 Measures the pressure after the column and all other
sensors. Part of the safety monitoring of the medium
pressure.

1 Not applicable.

The following illustration shows the gradient flow section.
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Flow kit packaging
All parts of the flow kit are delivered in double plastic bags and are pre-treated with
gamma radiation or autoclaving.

Flow kit components are labeled and equipped with bar codes. The bar codes are
primarily used for traceability.
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3.5.2 Flow kit sensors

Introduction
This section describes sensors that are part of the flow kit. For further details see the
product documentation package provided with the system.

Conductivity sensor
The conductivity sensor, CE-101, is primarily used to verify the conductivity of buffer
solutions. The conductivity measurement is temperature-compensated and therefore
relies on correct temperature readings. The conductivity sensor cable is connected to
the system cabinet using a screw-on connector fastened by a nut. The standard setting
of the cell constant is 12.5 cm-1.

Flow meter
The flow meter, FE-141, measures the liquid velocity using ultrasound. Transducers
are connected to both sides of a straight channel in the flow meter cell. The difference
between upstream and downstream ultrasound velocity is measured and the result is
used to calculate the flow rate.

The temperature sensor window is located on the back of the flow meter.

UV sensor
The UV sensor, AE-131, is installed in the electrical cabinet. The UV sensor is a trans-
parent rectangular UV flow cell. A UV LED emits light at 280 nm through the liquid flow
path. Two detectors measure the UV absorbance of the liquid.

For correct measurements, the UV sensor must be properly fitted, kept clean and dry.

NOTICE

Make sure that the temperature of the process liquid is not more
than 10°C below the ambient temperature. Larger temperature
differences can cause condensation on the UV sensor.

Air sensors (optional)
The air sensors, AE-151 and AE-152, are optional accessories. The air sensors are high
precision monitors designed for continuous monitoring of air bubbles in the flow path.
When air is detected, the system is either paused, or performs an action that is defined
in the method.

The air sensors are connected to the CUSTOMER I/O connector as described in 
Connect air sensors, on page 69, and in a separate document ÄKTA ready air sensor
installation (29051561).

3 System description
3.5 Flow kits

3.5.2 Flow kit sensors

ÄKTA ready Operating Instructions 28960345 AG 44



Pressure sensor
The pressure sensors are designed with a flexible membrane that is brought into
contact with a transducer (load cell) on the system cabinet for measurement of fluid
pressure.

The flow kit comprises three pressure sensors that continuously measure the liquid
pressure. The following illustration shows the pressure sensor.

The location and the function of the pressure sensors is described below.

Pressure
sensor

Location Function

PT-111 In the high pressure flow path,
directly downstream of the
pumps.

Measures the pressure in the
flow path before the column.

PT-112 In the medium pressure flow
path, downstream of the
column.

Measures the pressure in the
flow path after the column. The
difference between pressures
at PT-111 and PT-112 is the
pressure drop over the column
and the packed bed.

PT-113 In the low pressure flow path,
upstream of the outlet mani-
fold.

Measures the pressure in the
flow path before the outlet
manifold. Prevents overpres-
sure caused by problems
downstream of the outlet (e.g.,
a blocked outlet tubing or an
overfilled bag collecting the
product).
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Temperature sensor
The temperature sensor, TE-161, measures the temperature using infrared radiation.

pH electrode (optional)
The pH electrode, AE-121, can be attached to a holder on top of the pressure sensor
PT-112. A pH electrode dummy is installed in the pH electrode holder at the flow kit
delivery.

The pH electrode must be calibrated at least once a day (see Section 6.4.1 Calibrate
sensors, on page 156).

NOTICE

The pH electrode must be sanitized with 70% ethanol before instal-
ling it into the flow kit.
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3.6 UNICORN control system

Overview
ÄKTA ready is controlled by UNICORN process control software.

UNICORN can save established processes as methods. The methods include the
instructions necessary for process operation and documentation.

UNICORN includes a comprehensive system of user access levels. The access levels
limit the operations a given user can perform on ÄKTA ready. Access to the system
should be given only to qualified and trained personnel.

Information on how to use UNICORN can be obtained from the UNICORN documenta-
tion and available tutorials. Contact your local Cytiva representative for advice if
required.

System operators are responsible for designing methods which conform to standard
operating procedures and Good Manufacturing Practice procedures.

This product and the product control system are technically developed to enable
customer organization to meet requirements in FDA 21 CFR Part 11.

UNICORN installation
UNICORN can be installed on a standalone computer to control several locally
attached systems. However, the computer can only show one system at a time. Output
data from one system can be displayed on multiple computers. UNICORN can also be
installed on a network.

Contact your Cytiva representative for more information.
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Software modules
The UNICORN control software consists of four modules.

Module Function

Administration File handling and administration tasks, for example
definition of systems and managing user profiles.

Method Editor Method creation and editing of preprogrammed
control of the system.

System Control Online process control and monitoring using prede-
fined methods or manual control.

Evaluation Evaluation and presentation of stored results. Two
evaluation modules are available.

• Evaluation.

• Evaluation Classic (requires an additional e-
license).

See the data file 29135786 for the description of the
modules.

Note: The modules are active when the program is operating and are not closed
when minimized. For example, a minimized System Control module may
be active and control a process.

UNICORN warnings
UNICORN warnings tell the operator that process parameters have exceeded the
defined high or low limits. The method continues to run.

Alarms
If the equipment connected to the system has lower alarm limits than the system, the
alarm must be adjusted to that lower value.

The following happens when a signal triggers an alarm:

• The system is set to Pause mode.

• Valves and other components move to default positions.

• Certain components (air trap, column) can retain the current valve positions if
Valve Pause Function is enabled in UNICORN.
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4 Installation

About this chapter
This chapter describes how to transport and install ÄKTA ready. The components are
either fitted on the system or provided as part of the flow kit.

In this chapter

Section See page

4.1 Safety precautions 50

4.2 Site requirements 53

4.3 Included in the delivery 54

4.4 Unpacking 55

4.5 Transport 58

4.6 Connections 61

4.7 Finish installation 70
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4.1 Safety precautions

WARNING

The product must be installed and prepared by Cytiva personnel or
a third party authorized by Cytiva.

WARNING

Move transport crates. Make sure that the lifting equipment has
the capacity to safely lift the crate weight. Make sure that the crate
is properly balanced so that it will not accidentally tip when moved.

WARNING

Electrical shock hazard. All installation, service and maintenance
of components inside the electrical cabinet must be done by
personnel authorized by Cytiva.

WARNING

Heavy object. The ramp is not reinforced in the center. Do not use
a pallet lifter or forklift on the ramp.

WARNING

Heavy object. When rolling the system down the ramp take great
care to avoid the wheels slipping off the edge of the ramp.

WARNING

Heavy object. Because of the significant weight of the product,
great care must be taken not to cause squeezing or crushing inju-
ries during movement. At least two, but preferably three or more,
people are recommended when moving the product.

WARNING
Access to power switch and power cord. The power switch
must always be easy to access. The power cord must always be
easy to disconnect.
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WARNING

Protective ground. The product must be connected to a
grounded power outlet.

WARNING

Supply voltage. Before connecting the power cord, make sure
that the supply voltage at the wall outlet corresponds to the
requirements for the instrument.

WARNING

All electrical installations must be performed by authorized
personnel only.

CAUTION

The wheels of ÄKTA ready must be locked during normal use. The
wheels must be unlocked only when moving the system.

CAUTION

Make sure that all tubing, hoses and cables are placed so that the
risk of tripping accidents is minimized.

CAUTION

The product is designed for indoor use only.

CAUTION

Make sure that the common waste outlet is never exposed to back-
pressure.
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NOTICE

Disconnect power. To prevent damage to the system, always
disconnect the power from the product before an module is
removed or installed, or a cable is connected or disconnected.
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4.2 Site requirements

Dimensions of ÄKTA ready

Property ÄKTA ready ÄKTA ready gradient

Width × Depth × Height 100 × 80 ×165 cm 116 × 80 × 165 cm

Weight (approximately) 230 kg 250 kg

Space required at produc-
tion location1

280 × 300 cm 280 × 316 cm

1 Including 100 cm free space on all sides of the system.

The additional space at production location is required for containers and hoses, and
for easy access to the power switch and the connectors on the back of the system. The
back door of the cabinet must be accessible for service.

Compressed air

• Dry and particle free air

• Airflow 50 NL/min or 6.25 L/min at 7 bar g

• Working pressure 5.5 to 10 bar g

An air hose (5 m, inner diameter of 7.5 mm) for connection to the compressed air
supply is delivered with the system.

Electrical power
The following applies at the delivery:

• A system power cable with an IEC 60309 connector is permanently attached to the
back of the system cabinet.

• The system is preconfigured for 230 V AC, 50/60 Hz power supply.
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4.3 Included in the delivery

General
ÄKTA ready is delivered with the following components:

• System cabinet

• Column trolley

• Box containing an accessory kit, system documentation folder, and user documen-
tation

ÄKTA ready is delivered pre-assembled in the transport crate. No specific assembly
prior to site installation is required.

Accessory kit
The accessory kit includes the following:

• Bar code scanner (USB)

• Two computer network cables (10 m and 3 m), and an RJ45 coupling connector

• Key for the back door of the system cabinet

• Compressed air tubing (5 m)

• Connector (female) for connecting equipment to CUSTOMER I/O (male) connector

• DVD containing UNICORN and ÄKTA ready strategy software

• User documentation, including UNICORN and ÄKTA ready manuals

• Product documentation package

• System logbook

• Labels for configured voltage

A 10 mm wrench for the bolts holding the pump lid is located on the inside of the
cabinet front door.

Associated products

• Flow kit (Low Flow Kit or High Flow Kit)

• Gradient flow section (Low Flow or High Flow section)

• ReadyToProcess columns

The associated products are ordered separately.
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4.4 Unpacking

Introduction
This section describes how to unpack ÄKTA ready and the flow kit in a safe way.

In this section

Section See page

4.4.1 Unpack ÄKTA ready 56

4.4.2 Unpack the flow kit 57
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4.4.1 Unpack ÄKTA ready

Instructions for unpacking
There are no loose parts in the crate. All parts are either attached to the system or
located in the accessory kit box.

For a full description on how to unpack ÄKTA ready refer to the following instructions:

• For ÄKTA ready: ÄKTA ready Unpacking Instructions (28994489)

• For ÄKTA ready gradient: ÄKTA ready gradient Unpacking Instructions (29042082)

Check for damage
Check the system for damage before starting assembly and installation. If any damage
is found, document the damage, and contact your Cytiva representative.
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4.4.2 Unpack the flow kit

Flow kit package
ÄKTA ready flow kits are delivered in double plastic bags.

The flow kit package contains the following items:

• Main part of the flow kit

• Inlet manifold

• Pump tubing, including two TC clamps with gaskets

• Petroleum jelly

• Product documentation package

Unpack flow kit

NOTICE

Use caution when opening the plastic bags to avoid damaging the
flow kit.

Unpack ÄKTA ready flow kit as follows:

Step Action

1 Cut open the outer plastic bag in a clean environment near the ÄKTA ready,
for example in the air lock, if the system is in a clean room.

2 Take out the items and move the flow kit components to the ÄKTA ready
system. Take out the components from their inner plastic bags immediately
before installing the flow kit onto the system cabinet.

ÄKTA ready flow kits have plastic end caps to protect the connectors from contamina-
tion. Do not remove the end caps until immediately before connecting the flow kit to
buffer bags or tanks, and to the column.
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4.5 Transport

Before moving the system

Before moving the system, make sure that:

Step Action

1 The power supply to the product is switched off.

2 All power cords to the product are disconnected.

3 All air supply lines to the product are disconnected.

4 All process lines to the product are disconnected.

5 All communication cables to the product are disconnected.

Result:
The system is now safe to move.

Release brakes to move ÄKTA ready
The ÄKTA ready can be rolled on hard and level surface when brakes on the casters are
released.

After positioning the system at its designated location, lock the casters.

Use the handle to move ÄKTA ready
Use the handle on the left side of the cabinet to move the system.
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Lifting ÄKTA ready
There are no lifting hooks on ÄKTA ready. Use a forklift or a pallet jack with a minimum
capacity of 400 kg for lifting the system. Appropriate safety precautions must be
followed.

CAUTION

Do not attempt to lift the system by the handle on the left side of
the system cabinet. The handle is for maneuvering the cabinet on
the floor, not for lifting.
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Center of gravity
The center of gravity for ÄKTA ready is indicated with a dash-dotted vertical line in the
drawings below.

Note: The center of gravity line is located slightly towards the back of the cabinet.
This causes a tipping hazard and must be taken into consideration when
moving or lifting the cabinet.
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4.6 Connections

Introduction
This section describes how to connect the power, compressed air, computer, and
equipment to CUSTOMER I/O connector of the ÄKTA ready.

In this section

Section See page

4.6.1 Connect power 62

4.6.2 Connect compressed air 64

4.6.3 Connection of COMMON WASTE Outlet 65

4.6.4 Connect computer 66

4.6.5 Connect equipment to CUSTOMER I/O connector 67
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4.6.1 Connect power

Power connection

NOTICE

Do not turn on the MAINS POWER switch before all connections
are made.

The mains power supply must be connected and configured by authorized service
personnel. Contact your Cytiva representative for help.

Grounding and protective earth

• The protective earth wire must be connected to system ground.

• Ground impedance must conform to the requirements of national and local indus-
trial safety regulations and/or electrical codes.

• The integrity of all ground connections must be periodically checked.

Mains cable
ÄKTA ready system is delivered with a permanently mounted power cable equipped
with an IEC 60309 connector without a plug.

The customer must supply a power plug for the mains cable. The power plug and the
socket must comply with the national regulations. The customer must install the
power plug on the mains cable, and follow the wire color code shown in the Cytiva elec-
trical drawing. The installation must be performed in accordance with the local codes.

If the mains cable needs to be replaced, the replacement cable must meet the mains
cable specifications. Refer to General Specification for the details. The cable must be
installed according to national regulations. Contact the Cytiva service personnel for
help.

Electrical requirements
The system is preconfigured for 240V 50/60 Hz AC power supply. The supply voltage
can be reconfigured on the T1 transformer if required.

Parameter Specification

Supply voltage 100 to 240 V AC ±10%

Uninterruptable power supply (UPS) and surge
protectors are recommended.

Frequency 50 or 60 Hz

Max power 1000 VA
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Parameter Specification

Fuse 16 A

Number of wall outlets Two outlets

• One for the ÄKTA ready system.

• One for the computer.

Note:

Power outlets must be within 1 meter from the instru-
ment and the computer.
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4.6.2 Connect compressed air

Connection instructions

CAUTION

Make sure that correct compressed air pressure is always main-
tained. Too high or too low pressure can be hazardous and can
cause erroneous results and leakage.

Follow the instruction to connect the compressed air supply to the system.

Step Action

1 Connect the compressed air supply to the air input connector on the back of
the system, labeled PNEUMATIC AIR SUPPLY. Use the supplied 5 m air
hose (inner diameter 7.5 mm).

2 Switch on the air supply.

3 Verify that there are no air leaks.
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4.6.3 Connection of COMMON WASTE Outlet

Conditions for the COMMON WASTE
connection

Make sure that the following conditions are valid for the common waste outlet:

Step Action

1 Connect the COMMON WASTE to tubing with at least the same diameter as
the common waste outlet connection.

2 Connect the COMMON WASTE to tubing that allows maximum waste flow
to be transported away from the product without pooling.
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4.6.4 Connect computer

General
The computer must be installed and used according to the instructions provided by the
manufacturer of the computer.

It is recommended that the computer is dedicated to UNICORN and the related soft-
ware. Due to the risk for computer viruses it is also recommended that the computer is
not directly connected to internet.

See the UNICORN manuals for further details about software requirements and instal-
lation.

A 10 m network cable and a 3 m crossover network cable are delivered with the system.
To protect the system use only the cables delivered with the system.

Connect system directly to computer

Follow the steps below to connect the ÄKTA ready directly to the computer.

Step Action

1 Connect the 10 m cable to the RJ45 connector marked SYSTEM
COMPUTER on the back of the system.

2 Connect the other end of the cable to the computer.

Connect system to hub

Follow the steps below to connect the system to a switch or hub for control via a
network.

Step Action

1 Connect the 10 m cable to the RJ45 connector marked SYSTEM
COMPUTER on the back of the system.

2 Connect the other end of the cable to the 3 m crossover network cable.

3 Connect the crossover network cable to a switch or a hub.
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4.6.5 Connect equipment to CUSTOMER I/O connector

General
The CUSTOMER I/O connector is located on the left side of the system cabinet, below
the inlet valves. The connector is a 15 pole IP67-proof D-Sub male connector. A corre-
sponding female connector containing a screw terminal block with watertight housing
is supplied with the system.

The input voltage is 24 V (acceptable range 15 to 28 V), and the output signal is 24 V
(maximally 1 A).

The CUSTOMER I/O connector can be used for the following purposes:

• Send a signal to an external alarm device

• Receive a signal indicating that a UPS has been activated

• Connect air sensors

Connect an alarm or a UPS
The following information describes the setup for connecting an external alarm or a
UPS to ÄKTA ready using the CUSTOMER I/O connector. The connector is shown as
C1 in the illustrations further down.

The connector signals are described in the following table.

Pin
number

Signal

Pin 1 Remote alarm (A in the illustration below) digital output (+24 V)

Pin 4 GND, digital ground

Pin 11 UPS On (B in the illustration below), digital input (+24 V)

Pin 15 Digital supply voltage (+24 V)
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Pins 1 and 4 (see image below) provide an output for an alarm device (e.g., a warning
light, a buzzer, or similar device). The external alarm is triggered when the internal
alarm is activated.

1

4

C1

A
ÄKTA ready

+24 V

Pins 11 and 15 (see image below) are used to receive an On signal (B) from an optional
UPS during a power failure.

15

11

C1

B
l

ÄKTA ready

+24 V
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Connect air sensors
The two air sensors are connected to the CUSTOMER I/O as shown in the illustration
below. For more information, refer to ÄKTA ready air sensor installation (29051561).

Red

Black

Green (Test)

Orange

Air sensor 1 (Air_AE151)

3

5

6

7

+5 V

COM5V

Signal H

Signal V

Red

Black

Green (Test)

Orange

Air sensor 2 (Air_AE152)

13

14

9

10

+5 V

COM5V

Signal H

Signal V

ÄKTA readyCustomer I/O 
connector

4 Installation
4.6 Connections

4.6.5 Connect equipment to CUSTOMER I/O connector

ÄKTA ready Operating Instructions 28960345 AG 69



4.7 Finish installation

Establish computer connection

Follow the steps below to set up a connection between ÄKTA ready and the computer.

Step Action

1 Turn the MAINS POWER switch to I position.

Result:

The green POWER indicator lamp on the front of the system is turned on.
The light flashes slowly when communication with UNICORN is not estab-
lished.

2 Switch on the computer and the computer screen, and verify that a booting
process starts.

Result:
When the booting is completed, the UNICORN icon is displayed on the
desktop. The software is installed and available.

3 Double-click the icon to start UNICORN.

4 Verify that the green POWER indicator lamp displays a steady green light,
indicating that UNICORN can communicate with the system.

Equilibrate to temperature
After moving the system to a different temperature environment, allow the system to
adjust to the ambient temperature before use. The flow meter may need several hours
to adjust. If the system temperature is not properly equilibrated, the temperature read-
ings may be incorrect.
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Install the bar code reader

Follow the steps below to install and configure the bar code reader.

Note: The installation requires bar codes to be scanned from the Quick Start Guide
supplied with the bar code reader. The Quick Start Guide is also available on
the bar code manufacturer's website.

Step Action

1 Connect the bar code reader to the computer with a USB cable, as shown in
the Quick Start Guide.

2 Locate the USB Keyboard (PC) interface bar code in the Quick Start Guide
and scan it with the bar code reader.

3 Place the bar code reader in its holder.

Result:
The bar code reader beeps when the installation is complete.

4 Verify the bar code function using an empty Notepad document as
described below.

a. In the Windows start menu, in the search field, type notepad.

b. Click the Notepad item that is displayed as the search result.

Result:
An empty Notepad document opens.

c. Scan any bar code from the Quick Start Guide.

Result:
A text string appears in the Notepad document, if the bar code reader is
installed correctly.

If the bar code reader does not function, locate the Standard Products Default bar code
in the Quick Start Guide and scan the code with the bar code reader. Repeat steps 2 to 4
above.
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5 Operation

About this chapter
This chapter provides the information required to prepare, start, operate, and shut
down ÄKTA ready.

In this chapter

Section See page

5.1 Safety precautions 73

5.2 Start the system and log on to UNICORN 76

5.3 Install flow kit 78

5.4 Perform a component test 106

5.5 Connect a column 112

5.6 Set ÄKTA ready specific parameters in Method Editor 125

5.7 Run a method 134

5.8 Controlled shutdown 144
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5.1 Safety precautions

WARNING

Operating limits. Never exceed the operating limits stated in this
document and on the product nameplate.

WARNING
Hazardous biological agents during a run. After using
hazardous biological agents flush the whole system tubing with a
bacteriostatic solution, neutral buffer, and then water before doing
service or maintenance.

WARNING

Use columns that withstand expected pressures. Otherwise the
columns might rupture, resulting in injury.

WARNING

Do not touch any part of the pump while the pump is running.

WARNING

Never put fingers or any objects other than the intended tubing
into the pinch valve opening.

WARNING

Cap unused connections before operation. Make sure that all
connections not in use are capped or directed to waste to avoid
accidental hazardous leakage during operation.

WARNING

When the system is operated from a remote controlling computer,
the operator must always make sure that no one is present and
exposed when the system is started and that no one enters the risk
area around the system during operation.
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WARNING

Hazardous pressure. The flow rate may under no circumstances
exceed the specified column maximum flow rate. High flows might
affect the packed medium, causing the pressure to exceed the
specified column maximum pressure.

WARNING

Overpressure. Do not block the outlet tubing as this can create
overpressure and can cause injury.

WARNING

Pressurized flow path. During a power failure or emergency stop,
the equipment can remain pressurized. Make sure all lines and
vessels are depressurized before opening a line or vessel.

WARNING

Before use, make sure that the column is not damaged or other-
wise defective. Damaged or defective columns can leak or rupture.

CAUTION

Knowledge of how to use the control software is required to safely
operate the product. Refer to the control software user documen-
tation as required.

CAUTION

Do not insert your fingers or other objects into fans or other
moving parts.

CAUTION

Make sure the waste container is dimensioned for maximum
possible volume when the instrument is left unattended.
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CAUTION

Waste tubes and containers must be secured and sealed to
prevent accidental spillage.

NOTICE

Keep UV flow cell clean. Do not allow solutions containing dissolved
salts, proteins or other solid solutes to dry out in the UV flow cell. Do
not allow particles to enter the flow cell, as damage to the flow cell
can occur.

NOTICE

The flow rate must not exceed the specified column maximum flow
rate. Excessive flow can damage the packed bed and damage the
flow kit.

NOTICE

Verify that the chromatography resin, columns and system compo-
nents are compatible with NaOH at the concentration, time, and
temperatures used.

NOTICE

Make sure that tubing connected to the inlets have the same or
larger inner diameter than the inlets, and is not longer than 10 m, to
prevent negative pressure at the pump tubing inlet and damage to
the pump tubing.

NOTICE

Make sure that the temperature of the process liquid is not lower
than 10°C below the ambient temperature. Larger temperature
differences can cause condensation on the UV sensor cell.

NOTICE
It is optional to perform a flow kit installation test when installing a
flow kit. The test includes functional verification of the sensors.
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5.2 Start the system and log on to UNICORN

Introduction
ÄKTA ready is usually kept switched on between runs. The system is switched off only
during monthly maintenance and repair, or when not in operation for a longer period of
time (more than a few days).

Start ÄKTA ready

Follow the steps below to start the system.

Step Action

1 Turn the MAINS POWER switch (on the left side of the cabinet) to I position.

Result:
The green POWER indicator lamp on the front of the system is turned on.
The light flashes slowly when communication with UNICORN is not estab-
lished.

2 Start UNICORN (see the instructions further down), and wait until the
connection is established (the Run button on the toolbar displays green
color).

3 Verify that the green POWER indicator lamp displays a steady green light,
indicating that UNICORN can communicate with the system.

When ÄKTA ready is turned on, the system automatically performs a stray light calibra-
tion. Without the UV sensor this results in a very high calibration factor. Therefore
always perform a stray light calibration immediately after the flow kit is installed and
purged with water or other liquid.

Start UNICORN

Follow the steps below to start the UNICORN software.

Step Action

1 Log on to Windows.

2 Double-click the UNICORN icon on the Windows desktop.

Result:
The Logon dialog box is shown.

3 In the dialog box, select a user on the Users list and type the password.

If you log on for the first time, select the user default and type default as
the password.
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Step Action

4 Click OK.

5 In the System Control module, on the System menu, click Connect to
Systems.

Result:
A dialog box opens.

6 In the dialog box, do the following:

a. Select the check box for the applicable system.

b. Select the applicable option (Control or View).

c. Click OK.

Note:
The system name is specified during installation configuration.

Result:
When UNICORN is connected to the system, the Run button on the toolbar
displays green color, indicating that the system is ready to run.
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5.3 Install flow kit

Introduction
This section describes how to install the flow kit and the gradient flow section.

In this section

Section See page

5.3.1 Prepare for flow kit installation 79

5.3.2 Create flow kit installation method 81

5.3.3 Install the flow kit for isocratic run 83

5.3.4 Install the flow kit for gradient run 101

Safety precautions

NOTICE

Only use flow kits supplied by Cytiva.

NOTICE
It is optional to perform a flow kit installation test when installing a
flow kit. The test includes functional verification of the sensors.
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5.3.1 Prepare for flow kit installation

Before flow kit installation

• Locate the two TC clamps and gaskets supplied with the flow kit. Prepare three
additional clamps and gaskets (not supplied) that are required to install the flow kit
and run a component test.

• Prepare a disinfectant solution for sanitization of tubing connectors, for example
70% ethanol.

The flow kit connectors are covered with protective end caps at delivery. The protective
caps are removed during the installation. The user should store the protective caps,
they are needed to cover the connectors before flow kit disposal.

Perform system setup

Set up the system in the Administration module following the steps below.

Step Action

1 Click System Properties to open the System Properties dialog box.

2 In the dialog box, click Edit.

3 In the Edit dialog box, select the following check boxes as applicable for your
system and process.

Note:
Äkta_Ready is selected by default.
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Step Action

a. Select Äkta_Ready_Gradient, if your are working with
ÄKTA ready gradient system.

b. Select pH_Cell, if pH is to be measured.

c. Select LowFlow_Kit (default) or HighFlow_Kit, depending on the
installed kit.

d. Select one or both air sensors, if used: Air_AE151 and Air_AE152.

e. Select Service, if you want to display UV_131_S and UV_131_R in the
Run Data pane in the System Control module.

Note:
If Service is not selected, these UV options are not available.

f. Select Profibus_Config6 if not otherwise specified in the Functional
Test Record.

4 Click OK to close the dialog box.
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5.3.2 Create flow kit installation method

Create method

The user must simultaneously create the flow kit installation method and install the
flow kit. Follow the instructions in an applicable manual section to install the flow kit.

• To install the isocratic flow kit: Section 5.3.3 Install the flow kit for isocratic run,
on page 83.

• To install the gradient flow kit: Section 5.3.4 Install the flow kit for gradient run,
on page 101

For both flow kits, create the installation method in the Method Editor module
following the steps below.

Step Action

1 On the File menu, click New Method.

2 In the New Method dialog box, click Method Wizard, and then click OK.

3 In the Method Wizard, select the following options:

a. Gradient or Isocratic, depending on your system.

b. Flow kit Installation with Component Test.

c. Select the Print Report Automatically check box if you want to print a
report with installation information and test results.

Note:
A report can also be printed on demand after the completed test, in the Eval-
uation module.

4 Click Next to move to the next page in the Method Wizard.

a. On each new page select and confirm the options as applicable for your
system, and then click Next.

b. For installation of the flow kit on the system hardware, as requested in
the Method Wizard, follow the instructions in the applicable chapters
(Section 5.3.3 Install the flow kit for isocratic run, on page 83 or Section
5.3.4 Install the flow kit for gradient run, on page 101).
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Step Action

5 Save the created flow kit installation method.
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5.3.3 Install the flow kit for isocratic run

Introduction
The following sections contain a step-by-step description how to install the flow kit for
an isocratic run. The short outline of the procedure is also included as Flow Kit Instal-
lation in the ÄKTA ready Installation Wizard.

It is recommended to use the wizard for kit installation to make sure that all steps are
performed in the correct order.

For instructions on how to install the flow kit for gradient run, see Section 5.3.4 Install
the flow kit for gradient run, on page 101.

Alternatively, the flow kit can be assembled in a laminar flow cabinet. See Assembly in a
laminar flow cabinet, on page 99 for more information.
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Open safety locks on pinch valves

The safety locks keep the pinch valves in an open position. Follow the steps below to
open the safety locks.

Step Action

1 Make sure that UNICORN is in the End mode.

2 Locate the installation switch in the upper right corner of the system
cabinet.

3 Turn the installation switch to the FLOW KIT INSTALL position.

4 Lift the black handle of the valve safety lock and turn the handle outward 180
degrees. Open the safety locks on all 19 valves.
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Remove pump lid

Step Action

1 Locate the 10 mm wrench on the inside of the cabinet front door.

2 Locate the two bolts holding the pump lid.

3 Rotate the right-hand bolt counterclockwise, and the left-hand bolt clock-
wise using the wrench, until both bolts are fully open.

4 Verify that the pump lid is fully open: check the position of the two pegs at
the back of the lid. The pegs must be in their uppermost position.
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Step Action

5 Lift the pump lid and remove it from the pump.
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Open pressure sensor holders

Step Action

1 Locate the three pressure sensor holders for pressure sensors PT-111,
PT-112, and PT-113.

PT-113

PT-111

PT-112

2 Loosen the screws on the latches, and turn the latches to open position. Do
not remove the screws.

5 Operation
5.3 Install flow kit

5.3.3 Install the flow kit for isocratic run

ÄKTA ready Operating Instructions 28960345 AG 87



Attach the inlet manifold

Step Action

1 Open the bag containing the inlet manifold and the main part of the flow kit.

2 Attach the inlet manifold to the system: insert each inlet tubing into the
corresponding inlet pinch valve (XV-001 to XV-006).

Note:

Do not remove the protective end caps from the connectors.

3 Make sure that the spacer rings (shown in black, 1) on each inlet tubing are
fastened correctly:

• For a flow kit with only one spacer ring per inlet, fasten the spacer above
each inlet pinch valve as shown in the image below.

• For a flow kit with two spacers rings per inlet, fasten the spacers above
and below each inlet pinch valve.

1
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Step Action

4 Close the safety locks on the pinch valves: lift each black handle and turn the
handle inward 180 degrees.

Attach the main part tubing

Step Action

1 Lift the main part of the flow kit (see the illustration):

• Hold the air trap (1) in your left hand.

• Hold the UV sensor (2) in your right hand. Avoid touching the sensor walls.

1

2
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Step Action

2 Place the air trap in the holder, and insert the UV sensor in the slot to the
right of the air trap. Push the UV sensor in completely. A soft click indicates
that the sensor is correctly inserted.

3 Temporarily hang the outlet manifold on the cabinet door.

Install the pump tubing for isocratic
run

The following instructions are valid for an isocratic run. For installation of pump tubing
for a gradient run, see Section 5.3.4 Install the flow kit for gradient run, on page 101.

Step Action

1 Take the pump tubing out of the flow kit package.

2 Place the tubing on top of the pump rollers of the isocratic pump. The larger
connector block (for connection with the main part of the flow kit) must be to
the right of the pump.
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Step Action

3 Push the pump tubing over the knob on the right side of the pump.

4 Stretch the tubing, and push it over the knob on the left side.

5 Connect the connector on right side of the pump tubing to the flow kit using
a TC clamp.
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Step Action

6 Connect the connector on left side to the inlet manifold using a TC clamp.

Attach the pump lid

Step Action

1 Make sure that the pump lid is oriented in the correct way. The arrow label on
the lid indicates the flow direction and must point to the right. The pegs must
be located at the back of the lid, on the side closest to the system.

2 Press down the pump lid with one hand.

3 Attach the pump lid: rotate the right-hand bolt clockwise, and the left-hand
bolt counterclockwise using the wrench supplied with the system, until both
bolts are tight.

4 Verify the position of the pegs at the back of the lid. The pegs must be in their
lowermost position when the lid is closed. The system cannot work if the lid
is not properly attached.
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Install tubing and sensors

Step Action

1 Insert the tubing into the valves in the order specified below. Close the valve
safety lock on each valve after inserting the tubing.

a. Air trap valves (2)

b. Column valves (3)

c. Air release valve (1)

1

2

3

Note:

Make sure the pH cable does not get trapped behind the tubing. The cable
must stay attached to its holder on the cabinet.
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Step Action

2 Push the three pressure sensors into their respective holders on the cabinet
(sensors PT-111, PT-112, and PT-113).

3 Attach the pressure sensors to the cabinet: turn the latch over the pressure
sensor body and loosely fasten the screws (4, 5).

4

5

4 Verify that the sensor is correctly positioned and that there is no gap
between the sensor body and the holder, and then tightly fasten the screws.
Apply finger force only.

5 Align the holes in the body of the flow meter (FE-141) with the two knobs on
the cabinet (7 and 8 in the illustration), and push the flow meter onto the
knobs.

Note:

A window for the temperature sensor (6) on the back of the flow meter is
aligned with the temperature sensor when the flow meter is correctly
installed. No further action is necessary to prepare for temperature meas-
urements.
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Step Action

7

8

6

Result:
A soft click indicates correct assembly.

6 Clean the contact surfaces of the transducer connectors (bayonet
couplings) and apply a thin smooth layer of petroleum jelly. Make sure that
enough petroleum jelly is applied. Any surplus petroleum jelly is pressed out
and can be removed with a tissue when connections are made.

7 Connect the transducers to the connectors at the top and bottom of the flow
meter (see arrows in the illustration).

8 Unscrew the protective cap from the conductivity connector (on the system
cabinet).

9 Align the connectors: a ridge on the male connector (on the system cabinet)
and a groove on the female connector (on the cable).

10 Screw the conductivity sensor cable into the connector on the system
cabinet.

Note:
Do not use force when inserting the connector.
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Step Action

Attach the outlet manifold

Step Action

1 Attach the outlet manifold (3) to the system: insert each inlet tubing into the
corresponding outlet pinch valve (XV-051 to XV-056).

1 2 3

Note:

Do not remove the protective end caps from the connectors.

2 Make sure that the spacer rings (shown in black, 1) on each outlet tubing are
fastened correctly:

• For a flow kit with only one spacer ring per outlet, fasten the spacer above
each outlet pinch valve as shown in the image below.
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Step Action

• For a flow kit with two spacers rings per outlet, fasten the spacers above
and below each outlet pinch valve.

1

3 Close the safety locks on all pinch valves: lift each black handle and turn the
handle inward 180 degrees.

4 Push the air vent tubing (attached to the top of the air trap) onto the holder
(1) on top of the system cabinet.

5 Remove the protective end cap (2) from the end of the air vent tubing.

Note:

The air trap does not work if the protective cap is left in place.
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Install the pH electrode

Step Action

1 Unscrew the plastic fastening nut (2) on top of pressure sensor (PT-112) and
pull out the dummy (3) from the electrode holder.

PT-112

AE-121

2

3
5

4

1

2 Locate the pH cable on the system cabinet (in the storage position), and
unscrew the lower cable connector from the system cabinet.

Note:
Do not unscrew the upper connector.

3 Push the pH cable (1) through the fastening nut (2), and connect pH elec-
trode (AE-121) (5) to the cable.

4 Calibrate and sanitize the pH electrode. See Calibrate the pH electrode,
on page 160 for calibration instructions.

5 Make sure the O-ring (4) is in place in PT-112.

6 Push the pH electrode into the pressure sensor PT-112 and fasten it with
the nut (2).
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Complete the flow kit installation

Step Action

1 Verify that the safety locks on all pinch valves are closed.

2 Verify that the three pressure sensors are in place and properly connected.

3 Turn the installation switch to the RUN position.

Result:
All pinch valves are set to the run position.

4 Verify that the end cap on the air vent tubing of the air trap has been
removed.

5 Connect the air trap tubing to a waste hose.

NOTICE
The end of the air trap tubing must be directed away
from the operator.

Perform a component test after installation of a new flow kit. If the installation wizard is
used, a component test is automatically included in the installation procedure. See 
Section 5.4 Perform a component test, on page 106 for instructions.

Perform a stray light calibration. See Calibrate UV stray light, on page 126 for instruc-
tions.

Assembly in a laminar flow cabinet
It is possible to assemble the flow kit parts in a laminar flow cabinet, and then install the
assembled kit on the ÄKTA ready system. Although this procedure may decrease the
possibility for microbial contamination, Cytiva does not recommend the procedure.
The pre-assembly may lead to incorrect orientation of the flow kit parts and cause
tensions or damage the flow kit.

5 Operation
5.3 Install flow kit

5.3.3 Install the flow kit for isocratic run

ÄKTA ready Operating Instructions 28960345 AG 99



If pre-assembling the flow kit, make sure that the flow kit parts are correctly oriented
towards each other and towards the ÄKTA ready system (for example, the inlet and
outlet manifolds must be correctly oriented). The flow kit must fit on the system
without causing restrictions in the flow path. Loosen the TC clamps if needed, adjust
the kit components, and then tighten the clamps again.
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5.3.4 Install the flow kit for gradient run

Introduction
The following sections contain a step-by-step description on how to install the flow kit
for a gradient run, including the gradient flow section. The short outline of the proce-
dure is also included as Flow Kit Installation in the ÄKTA ready Installation Wizard.

It is recommended to use the wizard for kit installation to make sure that all steps are
performed in the correct order.

Start flow kit installation

All flow kit components are installed in the same way for both the isocratic flow kit and
the gradient flow kit, except the pump tubing and the gradient flow section that are
installed differently.

Install the gradient flow kit components as described in the following instructions.

Step Action

1 Open safety locks on pinch valves (see Open safety locks on pinch valves,
on page 84).

2 Remove the pump lids from both pumps (see Remove pump lid, on page 85).

3 Open pressure sensor holders (see Open pressure sensor holders,
on page 87).

4 Attach the inlet manifold (see Attach the inlet manifold, on page 88).

5 Attach the main part tubing (see Attach the main part tubing, on page 89).

Install the pump tubing and the gradient flow section as described in the following
section.

Install pump tubing and gradient flow
section

The following instructions are valid for a gradient run. For installation of pump tubing
for an isocratic run, see Install the pump tubing for isocratic run, on page 90.

Make sure that the pump tubing for a gradient run is installed in the appropriate pump,
as shown below.

Pump tubing delivery Install in pump

Isocratic flow kit package Gradient pump

Gradient flow section package Isocratic pump

Follow the steps below to install the pump tubing.
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Step Action

1 Take the pump tubing out of the isocratic flow kit package.

2 Place the pump tubing on the gradient pump rollers (pump P-202). The
larger connector block (for connection with the main part of the flow kit)
must be to the right of the pump.

3 Push the pump tubing over the knob on the right side of the pump.

5 Operation
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Step Action

4 Stretch the tubing, and push it over the knob on the left side.

5 Take the pump tubing and the jumper tubing out of the gradient flow section
package.

6 Place the pump tubing from the gradient flow section on the isocratic pump
rollers (pump P-201 ).

7 Push the tubing over the knobs on the right and left side of the pump.

8 Remove the jumper tubing from the gradient flow section package.

5 Operation
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Step Action

9 Connect the jumper tubing to the right side of the pump tubing on the
gradient pump (P-202) using a TC clamp.

10 Connect the other end of the jumper tubing to the right side of the pump
tubing on the isocratic pump (P-201).

11 Connect the inlet manifold to the left side of the pump tubing on the
isocratic pump (P-201) using a TC clamp.

12 Connect the gradient buffer B tubing to the left side of the pump tubing on
the gradient pump (P-202) using a TC clamp.

Complete flow kit installation

Follow the steps below to finish installing the gradient flow kit.

Step Action

1 Attach the pump lids (see Attach the pump lid, on page 92).

2 Close the pinch valves and install the pressure sensors and flow meter (see 
Install tubing and sensors, on page 93).

5 Operation
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Step Action

3 Install the conductivity sensor and the pH electrode (see Install the pH elec-
trode, on page 98).

4 Attach the outlet manifold (see Attach the outlet manifold, on page 96).

5 Finish the flow kit installation including the component test and the stray
light calibration (see Complete the flow kit installation, on page 99).

After completing the flow kit installation calibrate the gradient pump (see Section 6.4.2
Calibrate the gradient pump, on page 165.

Note: The isocratic pump does not need calibration.

5 Operation
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5.4 Perform a component test

Introduction
This section gives instructions on how to perform the component test, and describes
the test report.

In this section

Section See page

5.4.1 Run a component test 107

5.4.2 The test report 111

Safety precautions

NOTICE

Always perform a component test when installing a flow kit. The
component test verifies the functionality of the sensors.

5 Operation
5.4 Perform a component test
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5.4.1 Run a component test

Introduction
The component test is an option that can be included in the flow kit installation
method. See Create method, on page 81 for details.

The component test consists of a number of steps to verify the functionality of the
ÄKTA ready components, in particular the sensors. The following aspects are tested:

• The type of the flow kit (High Flow or Low Flow)

• Flow meter

• UV sensor

• Conductivity sensors

• Pressure sensors

Required solutions
The following solutions are needed for the component test:

Solution Preparation Low Flow Kit High Flow Kit

Wash solution Purified water or
20% ethanol

10 L 25 L

Test solution • 1.0 M NaCl

• 1.06 % (v/v)
acetone

• Purified water

5 L 10 L

Note: The test solution contains acetone and must be freshly prepared to avoid
evaporation.

Test solution preparation protocol templates are available on the ÄKTA ready
Strategy DVD.

Prepare the component test

Connect the inlets and outlets as described in the steps below.

5 Operation
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5.4.1 Run a component test

ÄKTA ready Operating Instructions 28960345 AG 107



Step Action

1 Remove the protective end cap from Inlet 6, and connect the wash solution.

Note:

Containers must not be placed lower than 1 m below the inlets (that is, floor
level).

2 Remove the protective end cap from the inlet for the test solution and
connect the test solution. Use the applicable inlet:

• Inlet 5 for ÄKTA ready

• Inlet 7 for ÄKTA ready gradient

3 Remove the protective end cap from Outlet 6, and connect waste tubing to
this outlet.

Run the component test

The component test is created as part of the flow kit installation method. All informa-
tion added by the user (for example notes) is included in the test report. Running a
component test takes about 10 minutes.

5 Operation
5.4 Perform a component test

5.4.1 Run a component test
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Follow the steps below to start the flow kit component test.

Step Action

1 In the System Control module, click File:Open, and select the applicable
component test.

Result:
The Start Protocol window opens.

2 On the Notes tab, verify the information. Type your input as applicable, and
then click Next to continue.

3 On the Questions tab, fill in the information as required, and then click Next
to continue.

Tip:
Scan the information using the bar code scanner, or type manually into the
text fields.

Note:
The Questions tab consists of two pages. Fill in the information on both
pages.

4 On the Result Name and Location tab, specify the file name and location
as applicable.

5 Click Start to start the component test.

See the following section for user actions during a component test.

5 Operation
5.4 Perform a component test
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Actions during a component test
The test progress can be followed in the UNICORN System Control module. Charts
show the response curves for the different sensors.

The software issues two messages during the test run.

1. A warning message informing that the UV stray light reduction is activated.

The message is for information only. The user can click Acknowledge to close the
message. The component test continues independently of user action.

The warning message can be disabled as described in Calibrate UV stray light,
on page 126.

2. A message requesting the user to fill the air trap. Do the following:

a. In the System Control module, click Continue to start filling the air trap.

b. Press and hold the AIR VENT button on the system cabinet, until the air trap is
filled to the half.

c. In the System Control module, click Continue.

Note: The user must fill the air trap as instructed above. The component test fails if
the air trap is not correctly filled.

Notes can be added manually at any time during the test run. The notes are included in
the test report. To open the notes dialog box click View →Documentation in the
System Control module.

5 Operation
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5.4.2 The test report

Print the test report

Information about an installation, including the results from the component test, are
stored and can be compiled into a printed report. The report can be printed from the
Evaluation Classic module. To switch to Evaluation Classic open the Evaluation
module, click File →Applications and select Switch to Evaluation Classic.

If the option Print report automatically was chosen initially in the installation wizard
(Create method, on page 81), the results from the component test run will be available
in the form of a printed report produced immediately after the test has finished.

If the option Print report automatically was not chosen, a printed report can be
created at a later time.

Follow the steps below to view or print the column test report.

Step Action

1 In the Evaluation module, click File →Report.

Result:
The Generate Report dialog box opens.

2 In the dialog box, select AKTA ready_FlowKit.

3 Click Print or Preview as applicable.

5 Operation
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5.5 Connect a column

Introduction
This section describes how to install a column on the system. The information in this
section is also available in Column Installation in the ÄKTA ready installation wizard.

The section also contains instructions for running a column efficiency test and for
column rinsing. Both instructions describe optional procedures that can be performed
in connection with installing a new column.

For more information refer to the documentation provided with the column.

Note: ReadyToProcess columns are factory tested and are supplied with a certifi-
cate stating the results from an efficiency test performed on the individual
column.

In this section

Section See page

5.5.1 Install a column 113

5.5.2 Run a column efficiency test (optional) 121

5.5.3 Rinse a column (optional) 124

5 Operation
5.5 Connect a column

ÄKTA ready Operating Instructions 28960345 AG 112



5.5.1 Install a column

Column types
ReadyToProcess columns are recommended for use with ÄKTA ready. Other types of
columns may be used, but may require special safety precautions. The columns must
be capable to withstand the maximum system pressure. If not, additional pressure
safety devices must be used to prevent a run from reaching too high pressure.

WARNING

Hazardous pressure. The flow rate may under no circumstances
exceed the specified column maximum flow rate. High flows might
affect the packed medium, causing the pressure to exceed the
specified column maximum pressure.

WARNING

Overpressure. Do not block the outlet tubing with, for instance,
stop plugs. Blocked outlet tubing can create overpressure and can
result in injury.

Contact a local Cytiva representative for more information about using products other
than ReadyToProcess columns with ÄKTA ready.

More information about columns and chromatography resin is found on the Cytiva
website.

Prime the flow kit
Before installing a column, the flow kit must be primed with liquid (e.g., purified water)
from Inlet 6 to the column valves, including the air trap.

The flow kit is automatically primed during a component test. Additional priming is not
needed if the component test has been performed before the column installation.

5 Operation
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Position the column

WARNING

Before use, check that the column is not damaged or otherwise
defective. Damaged or defective columns can leak or rupture.

Follow the steps below to position the column correctly.

Step Action

1 Place the column on the column trolley.

2 Position the column so that the column inlet tubing, marked BOTTOM
INLET, is turned toward the handle of the column trolley (1).

1

2 2
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Step Action

3 Roll the trolley into position between the system cabinet leg supports, and
lock the trolley wheels (2).

Note: Be careful when transporting smaller columns (for example 2.5 L) on the
trolley. Small columns are light and have a narrow base, and can be
unstable.

Create column installation method

The steps described in here follow the Column Installation steps in the ÄKTA ready
Installation Wizard. The user must simultaneously create the column installation
method, and connect and install the column. Follow the instructions in Connect the
column, on page 118 to install the column.

Create the column installation method in the Method Editor module following the
steps below.

Step Action

1 On the File menu, click New Method.

2 In the New Method dialog box, click Method Wizard, and then click OK.

3 In the Method Wizard, select the following options:

a. Gradient or Isocratic, depending on your system.

b. Include Efficiency Test of Column (optional).

c. Include Rinsing of Column (optional)

5 Operation
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Step Action

d. Select the Print Report Automatically check box if you want to print a
report with installation information and test results.

1

2

Note:
See Section 5.5.2 Run a column efficiency test (optional), on page 121 and 
Section 5.5.3 Rinse a column (optional), on page 124 for more information
about the efficiency test and rinsing.

Note:
A report can also be printed on demand after the completed test, in the Eval-
uation module.

4 Click Next to move to the next page in the Method Wizard.

a. On each new page select and confirm the options as applicable for your
system, and then click Next.

b. For installation of column hardware, as requested in the Method
Wizard, follow the instructions in Connect the column, on page 118.

5 Click Finish.

5 Operation
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Step Action

Result:
The Method Wizard closes.

6 In Method Editor, select Method Settings and verify that the information
is correct.

7 Select User Defined, and verify that the information is correct.

8 Save the column installation method.

9 Open the saved Column installation method from the System Control
module.

10 Fill in the applicable values for your column.

When the Column installation method is created and the column is correctly
connected to the system, follow the instructions in Section 5.5.2 Run a column effi-
ciency test (optional), on page 121, if applicable.
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Connect the column

Follow the instructions in the Method Wizard, as described in Create column installa-
tion method, on page 115, to connect the column and create the optional test
methods. Follow the steps below to connect a column hardware to the system when
following the wizard.

Step Action

1 Remove the welded tubing ends from the bottom inlet tubing on the column.

Note:
Store the welded tubing ends for sealing the column when it is disconnected.

2 Sanitize the connecting tubing with 70% ethanol.

3 To prevent air entering the column via the inlet, fill the column inlet up to the
top with 20% ethanol or 2% benzyl alcohol.

4 Remove the protective end cap from the column inlet tubing of the flow kit
(1). Connect the tubing to the bottom inlet tubing on the column using a TC
clamp.

1
2
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Step Action

5 Repeat steps 1 to 4 above for the column outlet connector (2). Connect the
outlet connector to the top inlet tubing connector on the column.

6 Turn the installation switch to the COLUMN INSTALL position.

Result:
The flow path from the air trap to the column opens.

5 Operation
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Step Action

7 Let the liquid flow from the air trap into the column. Press the AIR VENT
button on the system cabinet front to open the air trap and release the air. If
necessary, tap, flick or squeeze the tubing (arrows in the following illustra-
tion) to release the air, until the tubing is completely filled with liquid and no
more bubbles raise up to the air trap.

8 Turn the installation switch to the RUN position.

5 Operation
5.5 Connect a column

5.5.1 Install a column
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5.5.2 Run a column efficiency test (optional)

General
A column efficiency test can be included when creating the column installation
method with the installation wizard (see Create column installation method,
on page 115 for more information). When using the installation wizard, the test results
are included in the column installation report.

Alternatively, a column efficiency test can also be created in the Method Editor
module from a method template.

The column efficiency test must be run in stable conditions at room temperature. The
specified flow rates, volumes, and buffers must be used.

For more information about efficiency testing of columns refer to the application note
Efficiency test of ReadyToProcess columns (28919821).

Required solutions
The following solutions are needed for the column efficiency test.

Solution Composition Volume Connection
point

Wash solution Purified water or
20% ethanol

Depends on
column volume.
See Method
Wizard for infor-
mation.

Inlet 6

Test solution 2% (v/v) acetone
in column wash
solution

5 L Inlet 5

Note: The same solvent must be used in wash and test solutions to allow the
results to be compared between different tests. 20% ethanol gives lower
values than water and therefore influences the test results.

Run the test

If the Include Efficiency Test of Column option is selected in the Method Wizard
for column installation, the method for the column efficiency test is created automati-
cally. Save the test before running it, and adjust the test to fit a specific column, as
recommended in the Method Wizard.

Follow the steps below to start the column efficiency test.

Step Action

1 In the System Control module, click File →Open, and select the applicable
method.
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Step Action

Result:
The Start Protocol window opens.

2 On the Notes tab, verify the information. Type your input as applicable, and
then click Next to continue.

3 On the Questions tab, fill in the information as required, and then click Next
to continue.

Tip:
Scan the information using the bar code scanner, or type manually into the
text fields.

Note:
The Questions tab consists of two pages. Fill in the information on both
pages.

4 On the Result Name and Location tab, specify the file name and location
as applicable.

5 Click Start to start the column efficiency test.

Notes can be added manually at any time during the test run. The notes are included in
the test report. To open the notes dialog box click View →Documentation in the
System Control module.

View the test report

Follow the steps below to view or print the column test report.

Step Action

1 In the Evaluation Classic module, click File →Open →Result Navigator.

2 In the Result Navigator, select the applicable result file and open the file.

3 Click File →Report.

Result:
The Generate Report dialog box opens.

4 In the dialog box, select the format AKTAready_Column_T (1).

Note:
This format is specifically adapted for the column test report.
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Step Action

1

2

5 Click Print or Preview (2) as applicable.

A column test report does not state if the column has passed or failed the test. The user
is responsible for comparing the test results with provided acceptance criteria in order
to decide if the column has passed.

5 Operation
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5.5.3 Rinse a column (optional)

Introduction
The rinsing methods can be predefined or customized by the user. The predefined
method is included as an optional step in the column installation wizard (see Create
column installation method, on page 115).

Required solutions
Purified water or a low salt buffer is used for rinsing. See the column documentation for
buffer details. At least 6 column volumes are required. The exact volume is shown in the
column installation wizard.

If the same wash solution is used for rinsing and in the column efficiency test (see 
Required solutions, on page 121), also the same inlet should be used (Inlet 6).

Rinsing procedure
Column rinsing takes approximately 80 minutes. No user actions are required during
this time. It is possible to include notes during a run.
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5.6 Set ÄKTA ready specific parameters in Method Editor

Introduction
This section describes how to change specific features for ÄKTA ready in the UNICORN
Method Editor. The changes are applied to existing methods. See UNICORN manuals
for instructions on how to create methods.

In this section

Section See page

5.6.1 Set UV stray light calibration 126

5.6.2 Set flow meter fine tuning 128

5.6.3 Set totalizers 129

5.6.4 Set PressureFlowControl 131

5 Operation
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5.6.1 Set UV stray light calibration

Introduction
The UV sensor is automatically calibrated when a new flow kit is installed using the
installation wizard. In addition, manual calibration of the UV sensor can also be
included in the methods.

Calibrate UV stray light

Place this instruction to the beginning of a method. For the calibration the UV LED is
shut down and the stray light is measured during 15 seconds. Other UNICORN instruc-
tions cannot be executed at this time, make sure to delay the next instruction for at
least 20 seconds to avoid conflict. The base for the stray light calibration instruction
(Base) must be defined as Time.

Follow the steps below to add automatic stray light calibration to a method.

Step Action

1 In Method Editor, in the Instruction Box, expand Alarms&Mon.

2 Scroll down, and then click StraylightCalib_UV_AT_131 (1).

1
2

3 Click Insert (2).

When the method is executed and the stray light calibration starts, the
following message is shown:

Stray light reduction calibration. Do not perform any other instruc-
tion during the next 15 seconds.

5 Operation
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Step Action

The user must wait until the calibration is completed. No user action is
allowed during this time.

4 After 15 seconds, click Acknowledge.
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5.6.2 Set flow meter fine tuning

Introduction
The flow meter uses ultrasound to measure the flow rate. Fine tuning is used to correct
the measured flow rate for differences in sound speed through plastic and liquid.

If the refraction index of the liquid is very similar to the index of the plastic, the fine
tuning fails. This may happen for buffers with high salt concentration. The maximal
additional error of the flow rate measurement in case of failed fine tuning is ± one
percent unit, when temperature difference between process liquid and environment is
kept within 10°C.

If the system displays Fine_tuning_flowmeter_failed message, lubricant must be
applied to the transducers. See Apply lubricant to flow meter, on page 151 for instruc-
tions.

Enable or disable
Fine_tuning_flowmeter_failed
message

Follow the steps below to enable or disable the Fine_tuning_flowmeter_failed
message.

Step Action

1 In Method Editor, in the Instruction Box, expand Alarms&Mon.

2 Scroll down, and then click Fine_Tune_Fail_Report (1).

13

2

3 a. Click Enable (2) to enable the Fine_tuning_flowmeter_failed
message in case of fine tuning failure.

b. Click Disable to disable the message.

4 Click Insert (3).
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5.6.3 Set totalizers

Introduction
A totalizer monitors the accumulated volumes passing through an inlet or an outlet.
Every inlet or outlet has a specific totalizer.

Set totalizer

Follow the steps below to set or reset a totalizer, or activate a totalizer alarm. The
instructions are given for Inlet 1 as an example.

Step Action

1 In Method Editor, in the Instruction Box, expand Flowpath.

2 Scroll down, and then click Inlet1_Totalizer (1).

1

2

3

3 Click Enabled or Disabled (2).

4 Click Insert (3).

5 To reset a totalizer, do the following:

a. Expand Flowpath.

b. Scroll down, and then click Inlet1_Totalizer_Reset.

c. Click Insert.

6 To activate an alarm for an enabled totalizer, do the following:

a. Expand Alarms&Mon

b. Scroll down, and then click Alarm_Inlet1_Totalizer.

c. On the Setpoint list, select an applicable volume (1.0 to 500 L).
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Step Action

d. Click Insert.

Note:
When an alarm is activated, the system is set in the Pause mode.
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5.6.4 Set PressureFlowControl

Introduction
The PressureFlowControl functionality is used to set limits to pressure and flow rate.
The functionality adjusts the flow rate to maintain the defined pressure, or maintains
the defined flow rate.

To activate the PressureFlowControl functionality, the parameters must be defined
in the correct order:

1. PressureFlowControl enabled.

2. Pressure, Flow, PressureFlowLimit values specified.

The system is paused when the specified limits are exceeded.

Enable PressureFlowControl

Follow the steps below to control the pressure and flow simultaneously during a run.

Step Action

1 In Method Editor, in the Instruction Box, expand Pump.

2 Scroll down on the Instructions list, and then click PressureFlowControl
(1).

1

3

2

3 Click Enabled (2).

4 Click Insert (3).
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Step Action

5 On the Instructions list, click PressureFlowLimit (4).

4
6

5

Result:
The parameters for the function are displayed.

6 On the Flow+ list (5), select an applicable value for flow rate deviation
(0.0 to 100 l/hour).

7 On the Pressure+ list (6), select an applicable value for pressure deviation
(0.00 to 1.00 bar).

8 Click Insert.

Disable PressureFlowControl

Follow the steps below to disable PressureFlowControl.

Step Action

1 In Method Editor, in the Instruction Box, expand Pump.

2 Scroll down on the Instructions list, and then click PressureFlowControl
(1).

1

3

2
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Step Action

3 Click Disabled (2).

4 Click Insert (3).
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5.7 Run a method

Introduction
This section describes how to start, monitor and end a method run.

Running a method on ÄKTA ready is automated. User interaction is required in the
preparation phase (for example connecting the column and containers, checking
connections and the flow kit). For information on method creation refer to UNICORN
Method Manual (29263510).

In this section

Section See page

5.7.1 Prepare before a run 135

5.7.2 Run a method 141

5 Operation
5.7 Run a method
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5.7.1 Prepare before a run

Safety precautions

WARNING

Hazardous substances and biological agents. When using
hazardous chemical and biological agents, take all suitable protec-
tive measures, such as wearing protective clothing, glasses and
gloves resistant to the substances used. Follow local and/or
national regulations for safe operation and maintenance of this
product.

WARNING

Corrosive substance. NaOH is corrosive and therefore dangerous
to health. When using hazardous chemicals, avoid spillage and
wear protective glasses and other suitable Personal Protective
Equipment (PPE).

CAUTION

Do not use chemicals at temperatures above the specified limits.

NOTICE

Do not run the system at higher temperatures than the specified
maximum operating temperature as stated on the system label.

5 Operation
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Connect containers
Connect the containers shown in the table below.

NOTICE

Make sure that tubing connected to the inlets have the same or
larger inner diameter than the inlets, and is not longer than 10 m, to
prevent negative pressure at the pump tubing inlet and damage to
the pump tubing.

Container Action

Buffers Connect the buffer inlet tubing to the appropriate buffer containers. The liquid
level in the inlet containers should be equal, and similarly equal in the outlet
containers.

Note:
Significant differences in the liquid levels can cause unintended mixing if the
valve switch time is too long. Set the valve switch time as applicable. See Set valve
switch time, on page 137 and Override valve switch time, on page 137 for instruc-
tions.

Samples Connect the sample inlet tubing to the appropriate sample containers.

Tip:

Use air sensors for optimal sample application. See Connect air sensor (optional),
on page 139 for more information.

Fractionation If fractionation is included in the method, connect the outlet tubing from the
outlet valves to applicable fraction collectors.

Waste Connect the waste tubing to a waste container. Make sure that the waste
container is dimensioned for maximum possible volume when the system runs
unattended.
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Set valve switch time

The valve switch time is a short period when two inlet valves or two outlet valves are
open simultaneously, as the flow is switched from one valve to another. This allows the
pump to run continuously without a blocked flow due to a closed inlet or outlet mani-
fold.

Keep the valve switch time as short as possible. A minimum switch time of 0.1 seconds
is required to prevent blockage.

Follow the steps below to set the valve switch time.

Step Action

1 In the System Control module, click System →Settings →Specials.

2 Click InletSwitchTime or OutletSwitchTime (1).

1

2

3 Set the Delay time between 0.1 to 5.0 seconds (2).

Note:
The default time is 1 second.

4 Click OK.

Override valve switch time

On very rare occasions, when simultaneous opening of two valves must be avoided,
valve switching can be done manually. Follow the steps below to switch the valves
manually.

Step Action

1 Stop the system pump.

2 Close the first valve.

3 Open the second valve.

4 Start the system pump.
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Set OutletCloseTime

The OutletCloseTime function specifies the length of the time delay before the outlet
valves are closed. This allows the system to get depressurized when the method ends.

Follow the steps below to set the OutletCloseTime.

Step Action

1 In the System Control module, click System →Settings →Specials.

2 Click OutletCloseTime.

3 Set the DelayTime between 1 to 30 seconds (2).

Note:
The default time is 7 seconds.

4 Click OK.

Valve position in Pause mode

When the system goes into the Pause mode, the air trap valve and the column valve
are set to their default positions. The user can disable this function: in such case the
valves remain in their current positions during Pause.

Follow the steps below to keep the air trap or the column in their current positions.

Step Action

1 In the System Control module, click System →System Settings.

2 Expand Specials.

3 Select AirTrapPauseFunction or ColumnPauseFunction (1), as appli-
cable.

1

2

4 Click Remain (2), and then click OK.

Check flow path
Before starting a run, verify that all parts of the flow path are prepared.
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• Make sure that the entire flow path, including the tubing to inlet containers, is filled
with liquid and that no air bubbles remain in the system.

If air reaches the flow meter during a run, a message Uncertain flow is displayed,
and the system goes to Pause mode.

The air trap can remove small amounts of air from the flow path.

• Prime each inlet, starting with Inlet 1. Use the ManFlow command to control the
pump during priming.

• Equilibrate the column with the solution used for the run, if the equilibration is not
included in the method.

Calibrate equipment
After changing the flow kit, verify the flow readings. If the reading is not shown as zero
when no flow is active, the flow meter must be calibrated. See Calibrate the flow meter,
on page 160 for instructions.

Before starting a run, make sure that the gradient pump is calibrated (see Section 6.4.2
Calibrate the gradient pump, on page 165.

Note: The isocratic pump does not require calibration.

Connect air sensor (optional)
Make sure that the air sensor is installed on the appropriate inlet tubing, and
connected to the CUSTOMER I/O port. The air sensor must be installed at appropriate
distance from the pump, allowing to stop the pump before air can enter the system.
The distance depends on the pump flow rate and the air sensor response time (0.01
min).

For detailed installation instructions, refer to ÄKTA ready air sensor installation
(29051561).

Select the applicable air sensor in the Administration module, in System Properties
→Edit.
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5.7.2 Run a method

Start a run

Follow the steps below to start a run.

Step Action

1 In the System Control module, click File →Open.

2 In the Method Navigator pane, double-click the applicable method.

Result:
The Start Protocol window opens. The window comprises several pages.

3

a. Verify and update the available parameters if needed.

b. Add information as requested.

c. Add comments if applicable.

d. Click Back or Next to navigate between pages in the Start Protocol.

Note:
See UNICORN manuals for detailed description of the options.

4 Click Start at the bottom of the window to initiate the run.
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Monitor a run
The progress of the run can be viewed in detail in the UNICORN System Control
module. Up to four separate panes can be displayed simultaneously to show different
aspects of the run. The layout of the window can be customized by dragging the panes
to suitable positions.

For more information regarding the monitoring possibilities in UNICORN refer to the
UNICORN System Control Manual (29191901).

End run automatically
If no unexpected events occur during the run, the method is finished automatically and
UNICORN goes to the End state. No user action is needed.

End run before method completion

To end the run before the method has finished follow the steps below.

Step Action

1 In the System Control window, on the toolbar, click the Stop button.

2 Click OK in the confirmation dialog box.

3 Save the (partial) results, if applicable.

If the stopped run is part of a scouting run, you can also end the scheduled scouting
runs. If this option is not selected, the next scouting run starts automatically.

5 Operation
5.7 Run a method

5.7.2 Run a method

ÄKTA ready Operating Instructions 28960345 AG 142



View results
The results can be viewed and saved using a UNICORN evaluation module. Two evalua-
tion modules are available: Evaluation and Evaluation Classic. Only the Evaluation
Classic module supports report formats that are linked to the Method Wizard.

See specific UNICORN manuals for more information about viewing results and
customizing the result layout.
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5.8 Controlled shutdown

Remove flow kit and column

WARNING
Hazardous biological agents during a run. After using
hazardous biological agents flush the whole system tubing with a
bacteriostatic solution, neutral buffer, and then water before doing
service or maintenance.

Do not leave a flow kit installed on the system for longer than a few days. The tubing
walls stick together where they are pressed. This can cause high pressure alarms when
the system is restarted.

Follow the steps below to disconnect and remove the flow kit and the column from the
system.

Step Action

1 Wash the column and the flow kit with water or a neutral buffer. Use a
washing method in UNICORN.

2 Disconnect the column, if the column is to be used in the future: follow the
steps a to c below.

a. Disconnect the column.

b. Put the welded tubing ends on the column inlet and outlet.

Note:
The welded tubing ends were removed when the column was connected.

c. Store the column as applicable.

3 Fill the column and the flow kit with air if the column is not used anymore and
needs to be disposed. Fill from an empty inlet, using the ManFlow
command.

4 Disconnect the column and all containers connected to the inlets and
outlets.

5 Put the protective caps on the inlet and outlet tubing. Put the welded tubing
ends on the column inlet and outlet.

Note:
The flow caps and the welded tubing ends were removed when the flow kit
and the column were installed.
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Step Action

6 Turn the installation switch to the FLOW KIT INSTALL position.

7 Remove all flow kit sensors from their holders or connectors.

8 Clean the contact surfaces of the flow meter connectors.

9 Open the safety locks on all pinch valves: lift the black handle of the valve
safety lock and turn the handle outward 180 degrees. Open the safety locks
on all 19 valves.

10 Remove the pump lid. See Remove pump lid, on page 85 for instructions.

11 Remove the inlet and outlet manifolds from the system cabinet.

12 Lift the pump tubing from the pumps.

13 Remove the flow kit from the system cabinet.

14 Dispose of the empty flow kit and the column. See Disposal of flow kit and
column, on page 191 for details.

Shutdown procedure

Follow the steps below to shut down the system.

Step Action

1 In any UNICORN module, click File →Exit UNICORN.

2 Wait until the software is closed.
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Step Action

3 Turn the MAINS POWER switch to the O position.
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6 Maintenance

About this chapter
This chapter provides schedules and instructions for preventive maintenance that
needs to be performed by the user of the ÄKTA ready system. Instructions for spare
part replacement, calibration, and cleaning are also provided.

In this chapter

Section See page

6.1 Safety precautions 148

6.2 Maintenance schedule 150

6.3 Maintenance procedures 151

6.4 Calibration 155

6.5 Cleaning 170

6.6 Storage 172
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6.1 Safety precautions

WARNING

Only personnel authorized by Cytiva are allowed to perform
service, installation, and maintenance of components inside the
cabinet.

WARNING

LOCK OUT / TAG OUT (LOTO). Before any maintenance or
decommissioning work is performed on the system, make sure that
the following conditions are fulfilled.

• The system is empty and depressurized.

• The system is disconnected from process feed, electrical power
and pneumatic supply.

• The system is prevented from accidentally becoming re-ener-
gized during maintenance.

• The system is clearly tagged as taken out of operation.

• All process wetted areas are clean and decontaminated.

WARNING

Use only approved parts. Only spare parts and accessories that
are approved or supplied by Cytiva may be used for maintaining or
servicing the product.

WARNING

Electrical shock hazard. All installation, service and maintenance
of components inside the electrical cabinet must be done by
personnel authorized by Cytiva.

WARNING
Electrical shock hazard. Always disconnect power before reset-
ting circuit breakers.
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WARNING
Hazardous biological agents during a run. After using
hazardous biological agents flush the whole system tubing with a
bacteriostatic solution, neutral buffer, and then water before doing
service or maintenance.

CAUTION
Connectors on the cabinet, such as connectors for pH, conduc-
tivity, network, etc., that are not used, should be plugged to prevent
cleaning liquid from entering the connector.

NOTICE

Disconnect power. To prevent equipment damage, always
disconnect the power from the product before a module is
removed or installed, or a cable is connected or disconnected.
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6.2 Maintenance schedule

Introduction
This section provides a schedule for daily and annual maintenance by the user. If the
actions suggested in this manual do not solve the problem or if the problem is not
covered, contact your Cytiva representative.

Preventive service must be performed annually by qualified service personnel author-
ized by Cytiva. Contact your local Cytiva representative for more information about the
available service agreements. Any abnormal behavior or aberrant noise must be exam-
ined and rectified. When a warning is displayed in UNICORN regarding one of the
components or sensors, follow the maintenance procedure described in this chapter. If
the problem is serious or recurrent, contact your local Cytiva representative.

Daily maintenance
The table below lists the daily maintenance actions.

Procedure Instructions

Clean the system. Section 6.5 Cleaning, on page 170

Calibrate the pH electrode. Calibrate the pH electrode, on page 160

Calibrate the gradient pump.1 Section 6.4.2 Calibrate the gradient
pump, on page 165

1 The gradient pump must be calibrated after installation of a new flow kit, or after replacement
of the pump tubing in only one pump.

Annual maintenance
The table below lists the annual maintenance actions. These actions can be performed
by the user or during annual service by Cytiva service personnel.

Procedure Instructions

Change the air filter. Replace the air filter, on page 153

Calibrate the pressure sensors. Calibrate the pressure sensors,
on page 162

Test the temperature sensor. Test the temperature sensor,
on page 152

Check the pump. Pump head maintenance, on page 154

Replace the UV LED and UV filter. The UV LED and UV filter must be
replaced every 5000 hours. Contact a
Cytiva service engineer for replace-
ment.
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6.3 Maintenance procedures

Apply lubricant to flow meter

If the warning Fine_tuning_flow_meter_failed is displayed in UNICORN, there may
be insufficient lubricant between the flow meter and the transducers. Follow the
instruction below to apply new lubricant.

Step Action

1 Allow the ongoing run to finish.

Note:

The maximal additional error of the flow rate measurement in case of failed
fine tuning is ±1%, in case the temperature difference between the process
liquid and the environment is more than 10°C.

2 Remove the transducers. See Install tubing and sensors, on page 93 for
instructions.

3 Wipe the transducer contact surfaces clean and apply a thin smooth layer of
petroleum jelly on the surfaces.

4 Reconnect the transducers.
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Test the temperature sensor

The accuracy of the temperature sensor can be tested with the Temperature Test Tool.
Contact Cytiva to order the tool.

Follow the steps below to test the temperature sensor.

Step Action

1 Remove the pH electrode or pH electrode dummy from the pressure sensor
PT112. Insert the Temperature Test Tool (4) and fasten it with the pH elec-
trode nut (2).

PT112

1

2

3

4

2 Insert a temperature probe, 3 to 6 mm in diameter (1), and tighten the top
nut (3) on the Temperature Test Tool.

3 Connect a calibrated temperature meter to the probe and start a manual
flow of approximately 50% (independent of the flow kit type).

4 Read the temperature on the reference temperature meter and compare
the reading to the temperature displayed in UNICORN (Temp_161). Calcu-
late the deviation.

5 If the temperature deviation is greater than described in the General Specifi-
cation, contact your Cytiva representative.
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Replace the air filter

Check the condition of the air filter regularly, it can become clogged under extreme
conditions. If the filter is dirty, follow the steps below to replace it.

Step Action

1 Locate the filter beneath the cabinet front panel (arrow in the illustration).

2 Remove the filter cover and the filter by unscrewing the six nuts (see the
illustration below). No tools are necessary.

3 Wipe clean the bottom surface of the cabinet and the filter cover.

4 Place the new filter in the cover with the gasket on top, and attach the filter
cover using the nuts. Use finger force to tighten the nuts.

Pressure sensor holder kit
A pressure sensor holder kit contains spare parts for pressure sensor holder (latches
and screws). When replacing a pressure sensor holder, turn the latch so that it does not
interfere with other components when opened. Use only finger force to tighten the
screws.
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Pump head maintenance
Changes in vibration or sound of the pump can indicate that pump components need
to be replaced. Contact your local Cytiva service engineer to change pump compo-
nents.

Replace wheels

Before replacing a wheel, carefully read the instructions about lifting and moving the
system, see Section 4.5 Transport, on page 58.

Follow the steps below to replace the wheels.

Step Action

1 Lift the system using a lifting device until the wheel is off the floor.

2 Loosen the four bolts that hold the wheel to the frame and the remove the
wheel.

3 Attach the new wheel using the same bolts.

4 Lower the system until it is standing on the floor.
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6.4 Calibration

Introduction
This section describes how to calibrate the sensors and the gradient pump.

In this section

Section See page

6.4.1 Calibrate sensors 156

6.4.2 Calibrate the gradient pump 165

6 Maintenance
6.4 Calibration

ÄKTA ready Operating Instructions 28960345 AG 155



6.4.1 Calibrate sensors

Introduction
This section describes how to calibrate the conductivity sensor, the flow meter, the pH
electrode, and the pressure sensors.

Calibrate the conductivity sensor

Calibration of the conductivity sensor is generally not needed, because the standard
setting of the cell constant that is used in UNICORN, is applicable for the most applica-
tions. If a higher precision of the conductivity measurement is required, it is recom-
mended to calibrate the conductivity sensor.

To calibrate the conductivity sensor follow the steps below.

Step Action

1 Prepare a calibration solution of 1.00 M NaCl (58.44 g/1000 mL). Let the solu-
tion equilibrate to room temperature to achieve correct measurement
results.

2 Set the temperature compensation factor to zero. Follow the steps a to e
below.

a. In the System Control module, on the menu, click System →Settings
to open the System Settings window.

b. In the Instructions box, expand Monitors.

c. Click CondTempComp (1).

1

2

d. On the CompFactor list (2), set the value to 0.0%.

e. Click OK.

3 Flush the cell with the calibration solution and fill the cell completely. Use at
least 15 mL solution.

4 Wait for 15 minutes after filling the cell, until the cell temperature is stable
between 20°C to 30°C.
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Step Action

5 In the System Control module, click System →Calibrate.

6 In the Calibration window, on the Monitor to calibrate list, select
Cond_Calibr (3).

7 Read the conductivity value in the Current value text box (4).

3 4
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Step Action

8 Read the theoretical conductivity value on the graph below, and compare
the measured value with the theoretical value.
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• If the measured value corresponds to the theoretical value, no further
action is needed.

• If the two values differ, proceed to next step.
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Step Action

9 Type the theoretical conductivity value in the Set the reference value box
(5).

5

6

10 Click Read value 1 (6).

Result:
The new conductivity cell constant is automatically calculated and updated.
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Calibrate the flow meter

The flow meter needs to be recalibrated (zero adjustment) when the flow readings
differ from zero under no flow conditions (for example, when the system is in the End
state), or when there is a difference between calculated and actual liquid consumption
caused by zero point offset.

Follow the steps below to calibrate the flow meter.

Step Action

1 Make sure that the flow kit is filled with liquid and that ÄKTA ready is in the
End state.

2 In the System Control module, click System →Calibrate.

3 In the Calibration window, on the Monitor to calibrate list, select Calib-
Flow (1).

2

1

4 Click Start Calibrate (2).

5 Verify that the flow rate value approaches zero.

Calibrate the pH electrode

pH calibration must be done at least once a day. Use pH standard solutions that are
applicable for your process.

Note: It is recommended to use fresh pH standard solutions for every calibration.

Step Action

1 Place two cups the pH standard solutions in the holder on the inside of the
cabinet front door.

2 Unscrew the lower cable connector from the system, and connect the pH
electrode to the cable (see Install the pH electrode, on page 98).

3 In the System Control module, click System →Calibrate.
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Step Action

4 Rinse the pH electrode with purified water and place the pH electrode in the
first standard solution.

5 Type the pH of the standard solution in the first Set the reference value
box (1), and wait for the current pH value to stabilize (2).

1

2

3

4

Note:
Only one text box is available at this time.

6 Click Read value 1 (3).

7 Rinse the electrode with purified water and place it in the other standard
solution.

8 Type the pH of the standard solution in the second Set the reference value
box, and wait for the value to stabilize.

9 Click Read value 2.

10 Wait until UNICORN calculates the slope and the asymmetry potential.

Result:
The slope and the asymmetry potential are shown (4).

11 Verify that the slope and the asymmetry potential are within the acceptable
range, as specified below.

• Slope >80%

• Asymmetry potential in the range of -60 to 60 mV.

For more information, refer to the guidelines in UNICORN help.

12 Click Close at the bottom of the Calibration window.

a. If the electrode passes, continue as described in step 13.

b. If the electrode does not pass, clean the pH electrode and repeat the cali-
bration.
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Step Action

13 Sanitize the pH electrode with 70% ethanol.

14 Wait until the pH electrode is dry, and then install the electrode as described
in Install the pH electrode, on page 98.

If the cleaning and the new calibration does not bring the parameters into the accept-
able range, replace the electrode. Refer to the manufacturer's manual for the pH elec-
trode for instructions on how to replace the pH electrode.

A new pH electrode typically has a slope of 95% to 102% and an asymmetry potential
within ± 30 mV. As the pH electrode ages, its slope decreases and the asymmetry
potential increases.

 +500 mV

 -500 mV

1

2

Voltage (mV)

pH

 7

Part Description

1 Asymmetry potential at pH 7

2 Calibration curve

Calibrate the pressure sensors

The pressure sensors need to be calibrated when the pressure readings differ from
each other more than ±0.20 bar, after completing an autozero procedure at atmos-
pheric pressure.

A pressure calibration cell and pump are needed for the calibration. Contact your
Cytiva representative for ordering information.

It is recommended to calibrate the pressure sensors without a flow kit attached to the
system. Follow the steps below to perform the calibration.
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Step Action

1 Install the calibration cell on pressure meter PT-111 (a calibration cell
without the pump tubing is shown in the illustration).

2 Apply up to 5 bar g pressure to the pressure sensor a few times until the
reading at atmospheric pressure is stable.

3 In the System Control module, click System →Calibrate.

4 In the Calibration window, on the Monitor to calibrate list, select PT111
(1).

2

1

3

5 Make sure that Low calibration value is set to 0.0000 bar g (2) and that the
cell is at atmospheric pressure (open the vent valve on the pump). Click
Read value 1 (3).

6 Close the vent valve on the pump, and run the pump until the pressure is
5 bar g. Make sure that High calibration value is set to 5.0000 bar g, and
select Read value 2.

7 Release the pressure and wait until atmospheric pressure is reached. Make
sure that the pressure reading is 0.00 ± 0.01 bar g.

8 Remove the calibration cell. Make sure that the pressure reading is
≤ -0.20 bar g. If the reading is higher, contact Cytiva.
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Step Action

Result:
PT-111 is calibrated.

9 Repeat the calibration procedure with pressure sensors PT-112 and
PT-113.

Note:
The holder for pressure sensor PT-112 is deeper than the other holders.
Insert an adapter block to install the calibration cell correctly (see the illus-
tration below). The adapter block is part of the pressure calibration tool.
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6.4.2 Calibrate the gradient pump

Description
The calibration procedure compensates for differences in capacity of pump A (P-201)
and pump B (P-202) at a given speed due to the pump tubing position and properties.
The flow rate and the pump speed (rpm) are linearly proportional. This linearity is used
to calculate a compensation factor (P202Factor) for synchronization of the pumps
and to gain a nominal volumetric gradient.

The FlowCompensation function must be activated for each run that uses a cali-
brated P-202 pump.

Prepare for calibration

The gradient pump calibration is always done manually. A column must be connected
to the system to make sure that the calibration conditions are similar to a real run.

Follow the steps below to remove the air bubbles from the system tubing.

Step Action

1 In the System Control module, click Manual →Execute Manual Instruc-
tion.

Result:
The Manual Instruction window opens.

2 Expand FlowPath, and specify the following parameters:

• Set Inlet to the correct inlet, then click Insert.

• Set Outlet to the correct outlet, then click Insert.

• Set AirTrap to Bypass, then click Insert.

• Set Column to Bypass, then click Insert.

3 Connect the inlet tubing to the applicable buffer container and the outlet
tubing to a waste container.

4 Start the isocratic pump manually:

a. In the Instructions box, expand Pump.
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Step Action

b. Select ManFlow, and then set the ManFlow value to 50%.

c. Click Insert, and then click Execute.

5 Run the pump until the flow rate is stable.

6 Set the gradient pump:

a. Expand Pump.

b. Select Gradient, and then set Target to 100% B.

c. Click Insert.

7 Start the gradient pump manually:

a. Expand Pump.

b. Select ManFlow, and then set ManFlow to 50%.

c. Click Insert, and then click Execute.

8 Run the gradient pump until the flow rate is stable.

9 On the toolbar, click the Pause button.

Calibrate the gradient pump

Follow the steps below to calibrate the pump B (P-202).

Step Action

1 Set the flow rate:

a. Expand Pump, select Gradient, and then set Target to 0% B.

b. Select Flow.

c. Set the FlowRate to at least 20 L/h for LowFlow Kit and 40 L/h for High-
Flow Kit.
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Step Action

d. Click Insert.

2 Set the column inline:

a. Expand FlowPath, and select Column.

b. Click Inline.

c. Click Insert, and then click Execute.

3 Wait until the flow rate is stable.

4 Set the P-201 pump instruction:

a. Expand Pump, and select P201Gain.

b. Click Execute.

c. Select Gradient, and set Target to 100% B.

d. Click Execute.

5 Wait until the flow rate is stable.
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Step Action

6 Set the P-202 pump instruction:

a. Expand Pump, and select P202Gain.

b. Click Execute.

c. Select FlowCompensation, and then select ON.

Note:
FlowCompensation is switched off when a manual run or a method run
ends. FlowCompensation must be activated for each subsequent run.
See Activate flow compensation factor, on page 169 for instructions.

d. Click Execute.

Result:
The calibration changes the P202Factor value (the speed correction factor
to produce the same flow in both pumps). The value range is 0.95 to 1.05. The
P202Factor is displayed in the Run Data pane in the System Control
module. If P202Factor is not shown, follow the instructions in the next step
to display the value.

7 a. In the System Control module, click View →Run Data.

b. Right-click the Run Data pane, and then click Customize on the
shortcut menu.

c. On the Run Data Groups list, select the P202Factor check box.

8 On the toolbar, click End to finish the calibration.
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Activate flow compensation factor

The FlowCompensation function must be activated for each run that uses a cali-
brated P-202 pump. Follow the steps below to activate the function.

Step Action

1 In the System Control module, click Manual →Execute Manual Instruc-
tion.

Result:
The Manual Instruction window opens.

2 In the Instructions box, expand Pump, select FlowCompensation, and
then select ON.

3 Click Execute.
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6.5 Cleaning

Safety precautions

CAUTION

Connectors on the system (for example connectors for pH, conduc-
tivity, network) that are not used, must be plugged to prevent
cleaning liquid from entering the connector.

CAUTION

To avoid contamination, make sure the system is thoroughly
cleaned before changing the flow kit.

NOTICE

When cleaning the flow kit, use 0.5 M NaOH not longer than 2
hours. Flush the flow kit with a suitable rinsing liquid, for example a
neutralizing buffer, to remove the NaOH.

Cleaning
The system must be kept clean and dry for it to function properly. Clean the system by
following the instructions below.

• Remove all chemical stains and dust by wiping the outside surfaces of the system
and the pump with a clean moist cloth or tissue. Use water with weak detergent for
daily cleaning of the cabinet. 70% ethanol or 2-propanol (isopropanol) can be used
for sanitization.

• Remove salt crystals from around valves by rinsing carefully with water to and
wiping dry.

• Remove infectious or aggressive fluids from the system before service or mainte-
nance by running a CIP solution through the system. Make sure to clean all acces-
sible flow paths.

• Clean the inside of the pump lid and the rollers with water if liquid was accidentally
spilled into the pump. Dry all pump external surfaces to avoid corrosion. The interior
of the pump is particularly sensitive to NaOH, as it corrodes aluminum.

After cleaning
After cleaning do the following:

• Make sure there is no liquid on the UV detector windows. If necessary, wipe the
windows using soft absorbent tissue.
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• If NaOH was used, rinse the system flow path with a neutralizing buffer before
rinsing it with water.

Note: Rinsing the system flow path with water directly after cleaning with
NaOH causes the tubing inner walls to stick together.

• Rinse the flow path with water or a suitable liquid to remove the cleaning solution.
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6.6 Storage

Prepare for storage
If the system is stored for a period of more than a few days, perform the following:

• Remove the flow kit (see Remove flow kit and column, on page 144).

• Clean the cabinet (see Section 6.5 Cleaning, on page 170).

• Before moving the system, turn off the system power and air supply.

Do not leave a flow kit installed on the system for more than a few days. Over time, the
tubing walls stick together where the tubing is squeezed. This can cause high pressure
alarms when the system is restarted.
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7 Troubleshooting

About this chapter
This chapter provides required information to enable users and service personnel to
identify and correct problems that can occur when operating ÄKTA ready.

Problems related to sensors and valves are normally revealed during the component
test, for troubleshooting see Section 7.2 Troubleshooting a failed component test,
on page 181.

If the suggested actions in this guide do not solve the problem or if the problem is not
covered by this guide, contact your Cytiva representative.

In this chapter

Section See page

7.1 Troubleshooting the system 174

7.2 Troubleshooting a failed component test 181

7 Troubleshooting
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7.1 Troubleshooting the system

Air in flow path

Problem Corrective action

Air enters the flow path. The
alarm Uncertain flow is
displayed and the system
enters Pause mode.1

Identify the cause, for example, damaged tubing or connector, a
dislocated TC gasket, or inlet tubing not properly located in liquid.

In rare cases, cavitation due to negative pressure can cause air to
enter the flow path. Cavitation can be recognized by a hissing
noise. Check for kinks on flow kit tubing.

1. Locate and correct the problem. Check the flow path, including
the inlet containers.

2. Remove any air in the flow path using the ManFlow command
in UNICORN.

3. Click Continue on the toolbar to continue the run.

1 The air trap can remove small amounts of air from the flow path. Larger amounts of air reach the flow meter and
cause Uncertain flow alarm.

Compressed air

Problem

Compressed air failure during a
run. The alarm No air supply
to the system is displayed and
the system enters Pause
mode.

Identify the cause, for example, a malfunctioning air supply, or a
leaking air hose.

1. Make sure that the supply pressure is above 5.5 bar.

2. Correct the air supply problem.

3. Continue the run by pressing the PAUSE/CONTINUE button
on the system cabinet.
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Computer

Problem Corrective action

No system found when starting
up UNICORN.

1. Make sure the system is switched on.

2. Check communication cable and connectors.

3. If system is connected to a switch or hub, check that the cross-
over cable (3 m) is connected in series with the long (10 m)
cable.

4. Switch off the computer.

5. Turn off the MAINS POWER on the ÄKTA ready system, then
turn on the power again.

6. Restart the computer.

Communication failure during
a run. Contact between
computer and system is
broken.1

1. Make sure the system is switched on. Check network cables
and connectors.

2. Reboot the computer.

1 The system continues to run if the connection to the computer is broken. Data is stored locally and transferred to
the computer when the communication is restored.

Conductivity sensors

Problem Corrective action

Poor connection. Make sure the conductivity sensor connector cable is properly
connected to the system cabinet (see Install the pH electrode,
on page 98).

Wrong inlets used. Check that the wash solution is connected to Inlet 6 and the test
solution to Inlet 5.

Wrong composition of wash
solution or test solution.

Make sure that the liquids used are fresh and correctly prepared
(see Required solutions, on page 121).
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Problem Corrective action

Errors in temperature readings. The conductivity measurement is temperature compensated and
is dependent on correct temperature measurements.

1. Loosen the flow meter. Verify that the flow meter is properly
pushed onto the two knobs (see Install tubing and sensors,
on page 93). A gap between the temperature sensor window
and the sensor can cause incorrect measurements.

2. Wipe the temperature sensor window with soft tissue. Dirty or
damp sensor window can cause incorrect measurements.

3. Make sure that the system temperature is equal to the ambient
temperature.

4. Make sure that the temperature of the process liquid does not
differ from the ambient temperature by more than 10°C.

Flow meter

Problem Corrective action

The message Fine tuning flow
meter failed is displayed.

• The message indicates that there is not enough lubricant on
the transducers. Apply more lubricant as described in Apply
lubricant to flow meter, on page 151.

• When buffers with high salt concentration are used, you may
want to disable the message. See Enable or disable
Fine_tuning_flowmeter_failed message, on page 128 for
instructions.

Note:

The maximal additional error of the flow rate measurement in case
of failed fine tuning is ± one percent unit, when temperature differ-
ence between process liquid is kept within 10°C.

Incorrectly installed pump
tubing.

Check that the pump tubing has been correctly attached and the
pump lid is correctly closed. Make sure the pegs on the pump lid
are turned all the way down (see Install the pump tubing for
isocratic run, on page 90 and Attach the pump lid, on page 92).

Insufficient pump tubing
connection.

• Make sure the TC clamps connecting the pump tubing to the
main part of the flow kit and to the inlet tubing are properly
connected.

• Make sure the TC gaskets are in the correct position.
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Problem Corrective action

Cavitation (small air bubbles
produced by under-pressure),
which results in unstable flow
meter readings.

In rare cases, cavitation due to negative pressure can cause air to
enter the flow path. Cavitation can be recognized by a hissing
noise.

1. Check the flow path for kinks. Check the inlet containers.

2. Make sure the inlet tubing diameter is equal to or larger than
the inlet manifold tubing diameter.

3. Remove any air in the flow path using the ManFlow command
in UNICORN.

4. Click Continue on the toolbar to continue the run.

Flow kit and gradient flow section

Problem Corrective action

Overpressure. Overpressure can damage the flow kit. If overpressure is detected
and the air trap is in-line, press the AIR VENT button on the system
cabinet to reduce the pressure.

If overpressure is detected when the air trap is bypassed, perform
the following steps:

1. In UNICORN, set Manual Flow to 0, and set the air trap in-line.

2. Click CONTINUE in UNICORN, or PAUSE/CONTINUE on the
system cabinet.

3. Press the AIR VENT button on the system cabinet, until the
overpressure is released.

Too high outlet pressure. • Check that connected outlet is actually open.

• Check if the outlet is plugged. If so, remove the plug.

• Make sure the outlet tubing diameter is equal to or larger than
the outlet manifold tubing diameter.

• Check if the inner walls of the flow kit tubing stick together
where they are pressed. If so, replace the flow kit.

Power

Problem Corrective action

Power failure during a run. • Check the system circuit breaker.

• Check the external power supply.

See Power failure, on page 22 for the consequences.
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Problem Corrective action

Fuse blows repeatedly. Shut the ÄKTA ready down using the main switch and contact your
local Cytiva representative.

Pressure sensors

Problem Corrective action

Incorrect pressure measure-
ment.

• Make sure that the pressure sensor is correctly aligned in the
holder.

• Check that there is no gap between the pressure sensor and the
pressure sensor holder.

• If necessary, loosen the screws and adjust the sensor position
according to the instructions in Install tubing and sensors,
on page 93. Tightly fasten the screws, using finger force only.

Pump

Problem Corrective action

Pump is not working. • Check if the EMERGENCY STOP button has been pressed. See 
Restart after emergency shutdown or power failure, on page 23.

• Check if the pump lid is correctly attached and closed. See 
Attach the pump lid, on page 92.

• Check if a valid flow path is defined: at least one inlet and one
outlet must be open. Verify in UNICORN or on the system.

• A method without pump flow instruction is used. Check the
pump function:

1. In the Method Editor module, in the Instruction Box,
expand Pump.

2. Click ManFlow, and set a value > 1%.

If the pump is functional, make corrections in the method and
include a pump instruction.

• If the above actions do not solve the problem, contact your local
Cytiva representative.
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Problem Corrective action

Little or no flow. • Check if the connected inlet is closed.

• Check if the containers are placed lower than 1 m below the
inlets.

• Check if the inlet containers are empty.

• Check if the flow kit tubing is worn out. If so, replace the flow kit.

• Check if the flow kit tubing is kinked or squeezed, blocking the
flow. If so, reinstall or replace the flow kit.

• Check if there is air in the pump tubing. If so, increase the pump
speed to push the air to the air trap.

• Check if the pump rotor is slipping on the drive shaft. Contact
Cytiva service personnel for reparation.

Pulsation of liquid in flow kit. • Check that the viscosity of liquid is within specified range. Refer
to the General Specifications.

• Check if the pump speed is high enough. If necessary, increase
the pump speed.

Pump tubing travels over pump
rotor.

Make sure that tubing connected to the inlets have the same or
larger inner diameter than the inlets, and is not longer than 10 m.

UV sensor

Problem Corrective action

Drifting UV signal. Make sure the temperature of the process liquid is not more than
10°C below the ambient temperature. Large temperature differ-
ences can cause condensation on the UV sensor.

Wipe the UV sensor with a soft tissue to remove condensation, if
necessary.

UV signal does not return to
zero.

Insufficient light transmission.

Condensation on the UV sensor
cell.

UV absorption values are
> 5 AU, even without flow kit
installed.

Stray light calibration must be done with UV sensor installed.
Install a flow kit and do a stray light calibration, see Calibrate UV
stray light, on page 126.

Incorrect attachment of the UV
sensor.

Make sure that the UV sensor is pushed in all the way, see the
instructions in Attach the main part tubing, on page 89.

Wrong inlets used during
component test.

Check that the wash solution is connected to Inlet 6, and the test
liquid to Inlet 5.

Wrong composition of wash
solution or test solution.

Make sure that the solutions used are fresh and correctly prepared
(see Required solutions, on page 121).
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Valves

Problem Corrective action

The message Valve error is
displayed.

A valve lock may be open. Check the valve locks and close them.

Note:
Before closing the manual valve lock, make sure the valve is in open
position in the software.

1. Turn the installation switch to position FLOW KIT INSTALL.

2. Lift the safety lock handle and turn the handle inward 180
degrees.

3. Turn the installation switch back to RUN position.

If both the Valve error message and No air supply to the
system message are shown, the alarm is caused by a compressed
air supply failure. See Flow meter, on page 176.

Valve safety lock is open. Note:
Make sure that the end caps are in place on all unused inlets and
outlets before turning the installation switch to FLOW KIT
INSTALL. The liquid from the air trap may drain into the flow kit and
cause spillage.

Close the valve safety lock:

1. Turn the installation switch to position FLOW KIT INSTALL.

2. Lift the safety lock handle and turn the handle inward 180
degrees.

3. Turn the installation switch back to RUN position.

Tubing not correctly inserted in
a valve.

Note:
Make sure that the end caps are in place on all unused inlets and
outlets before turning the installation switch to FLOW KIT
INSTALL. The liquid from the air trap may drain into the flow kit and
cause spillage.

Insert the tubing correctly.

1. Turn the installation switch to position FLOW KIT INSTALL.

2. Open the valve lock.

3. Insert the tubing.

4. Close the valve lock.

5. Turn the installation switch back to RUN.
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7.2 Troubleshooting a failed component test

Introduction
When a component test fails, a Test Failed message is shown. For troubleshooting a
failed component test it is recommended to use the Troubleshooting option in the
installation wizard. This will focus specifically on the failed sensor and create a new
component test for retesting only the failed sensor.

After troubleshooting with the installation wizard a printed report with date and signa-
ture can be created, confirming that the troubleshooting has been performed.

See the following section for instructions on troubleshooting with the installation
wizard.

If this troubleshooting fails, see the general troubleshooting instructions in Section 7.1
Troubleshooting the system, on page 174.
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Troubleshoot with installation wizard

Follow the steps below to troubleshoot a failed component test using the installation
wizard.

Step Action

1 In the Method Editor module, click File →New Method.

2 In the New Method dialog box, select Method Wizard, and then click OK.

3 In the wizard, select Troubleshoot Failed Component Test, and then
select the applicable check boxes for the previously failed components for
additional troubleshooting.

4 Click Next, continue through all following pages. Follow the instructions on
each page to perform the corrective actions for the failed component.

Result:
The wizard creates a new method.

5 Save the method, and then run it in the System Control module.

The troubleshooting wizard runs an additional component test.
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7.2 Troubleshooting a failed component test

ÄKTA ready Operating Instructions 28960345 AG 182



8 Reference information

About this chapter
This chapter provides required information that is useful when installing, operating,
maintaining, and troubleshooting the ÄKTA ready system. It also contains ordering
information.

In this chapter

Section See page

8.1 Specifications 184

8.2 Chemical resistance 185

8.3 Environmental requirements 187

8.4 PID control 188

8.5 Recycling information 190

8.6 Regulatory information 192

8.7 Flow kit ordering information 204

8.8 More information 205

8.9 Health and Safety Declaration Form 206
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8.1 Specifications

System capacity

Property ÄKTA ready Low Flow Kit ÄKTA ready High Flow Kit

Volumetric flow
rates

3 to 175 L/h 7.5 to 510 L/h

Pump speed 225 rpm (100%) 340 rpm (100%)

Maximal pres-
sure, peri-
staltic pump

≥ 4.0 bar

The following table shows the pressure rating for the flow kit parts. The data is valid for
both Low Flow Kit and High Flow Kit.

Pressure rating Value

Low pressure inlet manifold 0.6 bar

High pressure flow path, upstream of column 5.0 bar

High pressure flow path, downstream of column 2.0 bar

Low pressure outlet manifold 0.95 bar

For more information about the ÄKTA ready system and the flow kits, refer to the
product documentation.
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8.2 Chemical resistance

Introduction
This section describes recommended cleaning agents for ÄKTA ready as well as the
chemicals allowed for use.

External surfaces

• Water with weak detergent must be used for daily cleaning of the cabinet.

• 70% ethanol or 2-propanol (isopropanol) can be used for sanitization.

Wetted parts
Only the flow kit components are wetted parts. Consider the compatibility of the
wetted parts and your process chemicals before using the system.

Contact your local Cytiva representative if you are not sure about the compatibility of
your process chemicals.

Allowed chemicals
The following table lists chemicals that may be used with ÄKTA ready. The concentra-
tions listed are not normally exceeded during an operating cycle. The maximal allowed
exposure time is 48 hours.

The table is intended as a guide. The effects of a chemical will generally be more severe
at higher temperatures. Note that the combined effects of chemicals have not been
taken into account.

Note: The percentage in the table is given in % (v/v).

Chemical Concentration

Acetic acid 1 M

Acetone 2.5%

Aqueous buffers pH 2-12 <0.3 M

Arginine 2 M

Ammonium sulfate 4 M

Benzyl alcohol 2%

DTE/DTT 100 mM

EDTA 100 mM

Ethanol 20%

Formaldehyde 0.1%

Glycerol 10%

Glycine 2 M
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Chemical Concentration

Guanidine hydrochloride 6 M

Hydrochloric acid 0.1 M

Imidazole 1 M

Mercaptoethanol 20 mM

Pluronic F-68 1%

Polyethylene glycol, PEG 500 5%

Polyethylene glycol, PEG 1000 1%

Polyethylene glycol, PEG 5000 1%

Potassium phosphate 1 M

1-propanol 5%

2-propanol 30%

SDS 1%

Sodium acetate 1 M

Sodium chloride 4 M

Sodium citrate 1 M

Sodium sulfate 1 M

Sodium hydroxide 0.5 M

(Maximum exposure time 2 hours)

Sorbitol 1 M

Sucrose 1 M

Triton X-100 1%

Tween 20 1%

Tween 80 1%

Urea 8 M
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8.3 Environmental requirements

Environmental specifications
The installation site must comply with the following specifications:

Process Parameter Specification

Operation Allowed location Indoor use only

Ambient temperature 2°C to 30°C

Relative humidity 20% to 95%, non-condensing

Air Dust-free filtered air

Atmospheric pressure 950 to 1050 mbar

Storage, system Ambient temperature -25°C to 60°C1

Storage, flow kit Ambient temperature 2°C to 30°C
1 Storage at room temperature is recommended.
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8.4 PID control

Introduction
PID control is a well established and widely used method for feedback control of
processes. This section contains general information about PID control, and how it is
used in ÄKTA ready.

Principles
A PID controller uses the difference (error) between the actual (measured) value and a
designated setpoint to calculate the adjustment required for keeping a process within
defined boundaries.

A typical PID controller is tuned using the following three parameters:

• P — The weight of the current error. Proportional to the error.

• I — The weight of the stationary, or long term change in the error. Reduces effects of
error “trends”.

• D — The weight of the current rate-of-change of the error. Reduces effects of short
term error changes.

PID parameters
In ÄKTA ready PID control is used to control the pump speed based on flow velocity, as
measured in the flow meter. The PID control values are also dependent on chromatog-
raphy bead size and liquid viscosity.

The default values for the PID parameters are shown in the following table.

Flow kit type P I D

Low Flow Kit 0.3 5 s 0 s

High Flow Kit 0.5 10 s 0 s

Set PID parameters

In most cases the default PID parameters can be used. If tuning is required, change the
I-parameter by large increments.

Follow the steps below to change I-parameter in UNICORN.

Step Action

1 In Method Editor, in the Instruction Box, expand Pump.
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Step Action

2 Click FlowTune (1).

1

2

2

3 Locate the I-parameter that corresponds to your installed flow kit (2):

• I_LowFlow for the Low Flow Kit.

• I_HighFlow for the High Flow Kit.

4 Change the I-parameter depending on the required change.

• Increase the I-parameter 2× to slow down control.

• Decrease the I-parameter 2× to speed up control.

5 Click Insert.
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8.5 Recycling information

Introduction
This section contains information about the decommissioning of the product.

CAUTION

Always use appropriate personal protective equipment when
decommissioning the equipment.

Decontamination
The product must be decontaminated before decommissioning. All local regulations
must be followed with regard to scrapping of the equipment.

Disposal of the product
When taking the product out of service, the different materials must be separated and
recycled according to national and local environmental regulations.

Recycling of hazardous substances

The product contains hazardous substances. Detailed information is available from
your Cytiva representative.

Disposal of electrical components

Waste electrical and electronic equipment must not be disposed of as unsorted munic-
ipal waste and must be collected separately. Contact an authorized representative of
the manufacturer for information concerning the decommissioning of the equipment.

Disposal of batteries
Waste batteries and accumulators must not be disposed of as unsorted municipal
waste and must be collected separately. Follow applicable local regulations for recy-
cling of batteries and accumulators.
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Disposal of flow kit and column

Make sure to follow local regulations when disposing of the flow kit and the column.
Consult the column documentation for further information about disposing the
column.

Follow the steps below for disposal of the flow kit and the column.

Step Action

1 Disconnect the flow kit and the column as instructed in Remove flow kit and
column, on page 144.

2 If required, autoclave the flow kit in an autoclave bag. Make sure to remove
the protective caps before autoclaving.

3 Dispose of the empty flow kit and the column in accordance with local regu-
lations.
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8.6 Regulatory information

Introduction
This section lists the regulations and standards that apply to the products.

In this section

Section See page

8.6.1 Contact information 193

8.6.2 European Union and European Economic Area 194

8.6.3 Great Britain 195

8.6.4 Eurasian Economic Union (Евразийский экономический
союз)

196

8.6.5 North America 198

8.6.6 General regulatory statements 199

8.6.7 China 200

8.6.8 Other regulations and standards 203
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8.6.1 Contact information

Contact information for support
To find local contact information for support and sending troubleshooting reports, visit 
cytiva.com/contact.

Manufacturing information
The table below summarizes the required manufacturing information.

Requirement Information

Name and address of manufacturer Cytiva Sweden AB

Björkgatan 30

SE 751 84 Uppsala

Sweden

Telephone number of manufacturer + 46 771 400 600
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8.6.2 European Union and European Economic Area

Introduction
This section describes regulatory information for the European Union and European
Economic Area that applies to the product.

Conformity with EU Directives
See the EU Declaration of Conformity for the directives and regulations that apply for
the CE marking.

If not included with the product, a copy of the EU Declaration of Conformity is available
on request.

CE marking

The CE marking and the corresponding EU Declaration of Conformity is valid for the
product when it is:

• used according to the Operating Instructions or user manuals, and

• used in the same state as it was delivered, except for alterations described in the
Operating Instructions or user manuals.

8 Reference information
8.6 Regulatory information

8.6.2 European Union and European Economic Area

ÄKTA ready Operating Instructions 28960345 AG 194



8.6.3 Great Britain

Introduction
This section describes regulatory information for Great Britain that applies to the
product.

Conformity with UK Regulations
See the UK Declaration of Conformity for the regulations that apply for the UKCA
marking.

If not included with the product, a copy of the UK Declaration of Conformity is available
on request.

UKCA marking

The UKCA marking and the corresponding UK Declaration of Conformity is valid for the
product when it is:

• used according to the Operating Instructions or user manuals, and

• used in the same state as it was delivered, except for alterations described in the
Operating Instructions or user manuals.
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8.6.4 Eurasian Economic Union (Евразийский
экономический союз)

This section describes the information that applies to the product in the Eurasian
Economic Union (the Russian Federation, the Republic of Armenia, the Republic of
Belarus, the Republic of Kazakhstan, and the Kyrgyz Republic).

Introduction
This section provides information in accordance with the requirements of the Tech-
nical Regulations of the Customs Union and (or) the Eurasian Economic Union.

Введение
В данном разделе приведена информация согласно требованиям Технических
регламентов Таможенного союза и (или) Евразийского экономического союза.

Manufacturer and importer
information

The following table provides summary information about the manufacturer and
importer, in accordance with the requirements of the Technical Regulations of the
Customs Union and (or) the Eurasian Economic Union.

Requirement Information

Name, address and telephone
number of manufacturer

See Manufacturing information

Importer and/or company for
obtaining information about
importer

Cytiva RUS LLC

109004, Moscow

internal city area Tagansky municipal
district

Stanislavsky str., 21, building 5, premises I,
offices 24,25,29

Russian Federation

Telephone: +7 985 192 75 37

E-mail: rucis@cytiva.com

Информация о производителе и
импортере

В следующей таблице приводится сводная информация о производителе и
импортере, согласно требованиям Технических регламентов Таможенного союза
и (или) Евразийского экономического союза.
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Требование Информация

Наименование, адрес и номер
телефона производителя

См. Информацию об изготовлении

Импортер и/или лицо для
получения информации об
импортере

ООО "Цитива РУС"

109004, г. Москва

вн. тер. г. муниципальный округ
Таганский

ул. Станиславского, д. 21 стр. 5, помещ. I,
ком. 24,25,29

Российская Федерация

Телефон: +7 985 192 75 37

Адрес электронной почты: 
rucis@cytiva.com

Description of symbol on the
nameplate
Описание символов на заводской
табличке

This Eurasian compliance mark indicates that the product is
approved for use on the markets of the Member States of the
Customs Union of the Eurasian Economic Union

Данный знак о Евразийском соответствии указывает, что
изделие одобрено для использования на рынках
государств-членов Таможенного союза Евразийского
экономического союза
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8.6.5 North America

Introduction
This section describes the information that applies to the product in the USA and
Canada.

NRTL certification

This symbol indicates that the product has been certified by Intertek, which is a US
Occupational Safety and Health Administration Nationally Recognized Testing Labora-
tory (NRTL).

This product conforms to UL Std. 61010-1 and is certified to CSA Std. C22.2 No.
61010-1-12.

FCC compliance
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause unde-
sired operation.

Note: The user is cautioned that any changes or modifications not expressly
approved by Cytiva could void the user’s authority to operate the equip-
ment.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.
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8.6.6 General regulatory statements

Introduction
This section shows regulatory statements that are applicable to more than one
geographical region.

KC marking

The KC symbol indicates RRA registration of compati-
bility in Korea. The registration number of the product
will appear beside the symbol.

이 기호는 한국에서 호환성에 대한 RRA 등록을 나
타냅니다. 제품의 등록 번호는 기호 옆에 나타납니
다.
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8.6.7 China

Introduction
This section describes the information that applies to the product in China.

有害物质声明 (DoHS)
Declaration of Hazardous Substances
(DoHS)

根据 SJ/T11364-2014《电子电气产品有害物质限制使用标识要求》特提供如下
有关污染控制方面的信息。
The following product pollution control information is provided according to SJ/
T11364-2014 Marking for Restriction of Hazardous Substances caused by electrical
and electronic products.
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电子信息产品污染控制标志说明
Explanation of Pollution Control
Label

该标志表明本产品含有超过中国标准 GB/T 26572 《电子电气产品中限用物质的
限量要求 》中限量的有害物质。标志中的数字为本产品的环保使用期，表明本
产品在正常使用的条件下，有毒有害物质不会发生外泄或突变，用户使用本产
品不会对环境造成严重污染或对其人身、财产造成严重损害的期限。单位为
年。
为保证所申明的环保使用期限，应按产品手册中所规定的环境条件和方法进行
正常使用，并严格遵守产品维修手册中规定的定期维修和保养要求。
产品中的消耗件和某些零部件可能有其单独的环保使用期限标志，并且其环保
使用期限有可能比整个产品本身的环保使用期限短。应到期按产品维修程序更
换那些消耗件和零部件，以保证所申明的整个产品的环保使用期限。
本产品在使用寿命结束时不可作为普通生活垃圾处理，应被单独收集妥善处
理。
This symbol indicates the product contains hazardous materials in excess of the limits
established by the Chinese standard GB/T 26572 Requirements of concentration limits
for certain restricted substances in electrical and electronic products. The number in
the symbol is the Environment-friendly Use Period (EFUP), which indicates the period
during which the hazardous substances contained in electrical and electronic prod-
ucts will not leak or mutate under normal operating conditions so that the use of such
electrical and electronic products will not result in any severe environmental pollution,
any bodily injury or damage to any assets. The unit of the period is “Year”.

In order to maintain the declared EFUP, the product shall be operated normally
according to the instructions and environmental conditions as defined in the product
manual, and periodic maintenance schedules specified in Product Maintenance Proce-
dures shall be followed strictly.

Consumables or certain parts may have their own label with an EFUP value less than
the product. Periodic replacement of those consumables or parts to maintain the
declared EFUP shall be done in accordance with the Product Maintenance Procedures.

This product must not be disposed of as unsorted municipal waste, and must be
collected separately and handled properly after decommissioning.
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有害物质的名称及含量
Name and Concentration of
Hazardous Substances

产品中有害物质的名称及含量
Table of Hazardous Substances’ Name and Concentration

部件名称
Compo-
nent name

有害物质
Hazardous substance

铅
(Pb)

汞
(Hg)

镉
(Cd)

六价铬
(Cr(VI))

多溴联苯
(PBB)

多溴二苯醚
(PBDE)

ÄKTA ready
28906261

X 0 0 0 0 0

ÄKTA ready 
gradient
29032038

X 0 0 0 0 0

0: 表示该有害物质在该部件所有均质材料中的含量均在 GB/T 26572 规定的
限量要求以下。

X: 表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T 26572
规定的限量要求。

• 此表所列数据为发布时所能获得的最佳信息.

0: Indicates that this hazardous substance contained in all of the homogeneous
materials for this part is below the limit requirement in GB/T 26572.

X: Indicates that this hazardous substance contained in at least one of the
homogeneous materials used for this part is above the limit requirement in
GB/T 26572

• Data listed in the table represents best information available at the time of
publication.

8 Reference information
8.6 Regulatory information

8.6.7 China

ÄKTA ready Operating Instructions 28960345 AG 202



8.6.8 Other regulations and standards

Introduction
This section describes the additional standards that apply to the product.

Additional design considerations
For additional design considerations, such as ASME-BPE, GMP and cGMPs information
refer to the product-specific specification information provided in the documentation
package delivered with each equipment.
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8.7 Flow kit ordering information

Introduction

NOTICE

Only use flow kits supplied by Cytiva.

Both the isocratic flow kit and the gradient flow kit are available with two tubing diame-
ters. The diameter determines the maximum flow rate. For other available flow kit
options, see the Cytiva website or contact your local Cytiva representative.

Isocratic flow kits

Product Inner diameter (mm) Product code

ÄKTA ready Low Flow Kit 6.4 28930182

ÄKTA ready High Flow Kit 9.5 28930183

Gradient flow section

Product Inner diameter (mm) Product code

ÄKTA ready gradient Low Flow
section

6.4 29021085

ÄKTA ready gradient High Flow
section

9.5 29021086
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8.8 More information

Spare parts and accessories
Additional information regarding spare parts and accessories can be found in the
product documentation package supplied with the system.

Contact your local Cytiva representative for more information and recommendations
on spare parts and accessories.

Contact Cytiva
Contact your local Cytiva representative for more information about the following
questions:

• Service

• Method optimization

• Ordering information

• Other issues not covered by this manual

Training
Cytiva recommends that all new operators attend the training courses available from
Cytiva. The courses provide necessary information for inexperienced operators to
safely operate ÄKTA ready. With the OptiRun™ virtual reality operator training you can
train new operators anywhere at any time on a virtual ÄKTA ready.

Courses in the field of bioprocess development and manufacturing are available from
Cytiva Fast Trak™ Training & Education.

For more information about training contact your local Cytiva representative.
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8.9 Health and Safety Declaration Form

On site service

 

 
 
 

Service Ticket #: 
 

 

To make the mutual protection and safety of Cytiva service personnel and our customers, all equipment and work areas must be 
clean and free of any hazardous contaminants before a Service Engineer starts a repair. To avoid delays in the servicing of your 
equipment, complete this checklist and present it to the Service Engineer upon arrival. Equipment and/or work areas  
not sufficiently cleaned, accessible and safe for an engineer may lead to delays in servicing the equipment and could be subject to 
additional charges. 
 

 Yes  No 
Review the actions below and answer “Yes” or “No”.  
Provide explanation for any “No” answers in box below. 

 

 

 

 

 

 

Instrument has been cleaned of hazardous substances. 
Rinse tubing or piping, wipe down scanner surfaces, or otherwise make sure removal of any dangerous residue. 
Make sure the area around the instrument is clean. If radioactivity has been used, perform a wipe test or other 
suitable survey. 

 

 

 

 

Adequate space and clearance is provided to allow safe access for instrument service, repair or 
installation. In some cases this may require customer to move equipment from normal operating location 
prior to Cytiva arrival. 

 

 

 

 
Consumables, such as columns or gels, have been removed or isolated from the instrument and from 
any area that may impede access to the instrument . 

  All buffer / waste vessels are labeled.  
Excess containers have been removed from the area to provide access. 

Provide 
explanation 
for any “No” 
answers here: 

 

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that the area 
has been made safe and accessible. 

Name:  Company or institution:    

Position or 
job title: 

 Date (YYYY/MM/DD):  

Signed: 
 

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980026 AD 04/2020 

On Site Service Health &
Safety Declaration Form
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Product return or servicing

 

Health & Safety Declaration Form 
for Product Return or Servicing 

 
 

Return authorization 
number: 

 and/or 
Service Ticket/Request: 

 

To make sure the mutual protection and safety of Cytiva personnel, our customers, transportation personnel and our environment, 

all equipment must be clean and free of any hazardous contaminants before shipping to Cytiva. To avoid delays in the processing of 

your equipment, complete this checklist and include it with your return. 

1. Note that items will NOT be accepted for servicing or return without this form 

2. Equipment which is not sufficiently cleaned prior to return to Cytiva may lead to delays in servicing the equipment and 

could be subject to additional charges 

3. Visible contamination will be assumed hazardous and additional cleaning and decontamination charges will be applied 

 Yes   No Specify if the equipment has been in contact with any of the following: 

  Radioactivity (specify)  

  Infectious or hazardous biological substances (specify)  

  Other Hazardous Chemicals (specify)  

Equipment must be decontaminated prior to service / return. Provide a telephone number where Cytiva can contact 
you for additional information concerning the system / equipment. 

Telephone No:   

Liquid and/or gas in equipment is:  Water 

 Ethanol 

 None, empty 

 Argon, Helium, Nitrogen 

 Liquid Nitrogen 

Other, specify  

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that 
the area has been made safe and accessible. 

Name: 
 Company or 

institution:   
 

Position or job title:  Date (YYYY/MM/DD)  

Signed:   

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980027 AD 04/2020 

To receive a return authorization number 
or service number, call local 
technical support or customer service.  
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A

Abbreviations, 13
Accessories, 205
Accessory kit, 54
Air filter, 153

replacement, 153
Air in flow path, 174

troubleshooting, 174
Air sensor, 44
Air trap, 34, 138

Pause mode, 138
valves, 34

ÄKTA ready , 53
dimensions, 53
weight, 53

ÄKTA ready gradient , 53
dimensions, 53
weight, 53

B

Bar code reader, 71
installation, 71

C

Calibrate, 156, 160, 162, 165
flow meter, 160
gradient pump, 165
pH electrode, 160
pressure sensor, 162
sensors, 156

CE, 194
conformity, 194
marking, 194

Center of gravity, 60
Chemical resistance, 185
Chemicals, 185
Cleaning, 170
Column, 35, 112, 113, 121, 124,
138, 144, 191

disconnect, 144
disposal, 191
efficiency test, 121
installation, 112
Pause mode, 138

rinse, 124
types, 113
valves, 35

Component test, 106–108, 111,
181

prepare, 107
start, 108
test report, 111
troubleshooting, 181

Components, 28, 30
illustration, connectors, 30
illustration, front, 28

Compressed air, 53, 174
connecting, 53
troubleshooting, 174

Computer, 66, 175
troubleshooting, 175

Conductivity sensor, 44, 175
troubleshooting, 175

Control unit, 32
CU-960, 32

Controlled shutdown, 145
CU-960, 32
CUSTOMER I/O, 67

D

Delivered items, 54
Dimensions, 53
Disposal, 191

flow kit and column, 191
Documentation, 11, 12

package, 12
related literature, 11

E

Electrical cabinet, 32
Emergency procedures, 21–23

emergency shutdown, 21
power failure, 22
restart, 23

Explosive environment, 18
precautions, 18

Index

ÄKTA ready Operating Instructions 28960345 AG 208



F

FCC compliance, 198
Flammable liquids, 18

precautions, 18
Flow kit, 39, 43, 57, 78, 79, 81,
83–85, 87–90, 92, 96, 99, 144, 177,
184, 191, 204

alternative installation
procedure, 99
attach inlet manifold, 88
attach main part tubing, 89
attach pump lid, 92
before installation, 79
connect pump tubing, 90
create installation method,
81
disconnect, 144
disposal, 191
finish installation, 99
flow rates, 184
install outlet manifold, 96
installation, 78, 83
labeling, 43
open pressure sensor
holders, 87
open valve locks, 84
ordering information, 204
remove pump lid, 85
sanitization, 79
system setup, 79
TC clamps, 79
troubleshooting, 177
unpacking, 57
what is delivered, 57

Flow meter, 44, 128, 151, 160, 176
calibration, 160
disable warning, 128
lubricate, 151
troubleshooting, 176

Flowchart, 36

G

General precautions, 15
Gradient flow kit, 39, 40, 101

installation, 101
Gradient flow section, 27, 39, 40,
42, 101, 204

ordering information, 204
Gradient pump, 27, 36, 165

calibration, 165

I

Illustration, 26–28, 30
connectors, 30
gradient system, 27
isocratic system, 26
system front, 28

Important user information, 6
Install, 83, 93–95, 98, 101

conductivity sensor, 95
flow meter, 94
gradient flow kit, 101
isocratic flow kit, 83
pH electrode, 98
pressure sensors, 94
tubing in pinch valves, 93

Installing and moving, 50
precautions, 50

Isocratic flow kit, 39, 83
installation, 83

L

Labels, 19, 20
safety labels, 20
system label, 19

Lifting, 59

M

Maintenance, 147, 148, 150
daily, 150
precautions, 148

Manufacturing information, 193
Method optimization, 205
More information, 205
Moving system, 70

temperature change, 70

N

Notes and tips, 9

O

On site service, 206
Operation, 73

precautions, 73
Ordering information, 204, 205
Outlet close time, 138

set, 138
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Personal protection, 17
precautions, 17

pH electrode, 46, 160
calibration, 160

PID control, 188
PID parameters, 188
Pinch valves, 34
Power, 62, 177

troubleshooting, 177
Pressure sensor, 153, 162

calibration, 162
holder kit, 153

Pressure sensors, 178
troubleshooting, 178

PressureFlowControl, 131
Prime system, 138
Product return or servicing, 207
Pump, 178

troubleshooting, 178
Pump head, 154

replacement, 154
Purpose of this manual, 8

R

Recycling information, 190, 191
decontamination, 190
disposal of electrical compo-
nents, 190
flow kit and column, 191
recycling of hazardous
substances, 190

Reference information, 183
Regulatory information, 192
Remove, 144

flow kit and column, 144
Replace wheels, 154
Restart after emergency, 23
Run, 135, 136, 141, 142

connect containers, 136
end automatically, 142
end, user action, 142
final preparations, 135
monitor, 142
start, 141

S

Safety labels, 20
Safety notices, 15

Safety precautions, 15
Sensors, 156

calibration, 156
Service, 150, 205

annual, 150
Skid, 32
Spare parts, 205
Specifications, 184
Storage, 172, 187
Stray light calibration, 76, 110
System, 184

capacity, 184
System nameplate, 19
System setup, 79

T

Temperature, 70
changes, 70

Temperature sensor, 46, 152
test, 152

Totalizers, 129
Training, 205
Transducers, 95, 128, 151
Troubleshooting, 173–181

air in flow path, 174
component test, 181
compressed air, 174
computer, 175
conductivity sensor, 175
flow kit, 177
flow meter, 176
power, 177
pressure sensors, 178
pump, 178
UV sensor, 179
valves, 180

Typographical conventions, 9

U

UK, 195
conformity, 195

UKCA, 195
marking, 195

Uncertain flow, 138
UNICORN , 47, 48

alarms, 48
control system, 47
overview, 47
software modules, 48
system networks, 47
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warnings, 48
Unpack, 57

flow kit, 57
UV, 126

stray light calibration, 126
UV sensor, 44, 179

troubleshooting, 179

V

Valve position, 138
Pause mode, 138

Valve switch time, 137
override, 137
set, 137

Valves, 180
troubleshooting, 180

W

Weight, 53
Wheels, 154

replacement, 154
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